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SUCH PORTIONS OF THE SOFTWARE ARE PROVIDED “AS IS” AND WITHOUT ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE.
In addition, the program and information contained herein are licensed only pursuant to a license agreement that contains 
restrictions on use and disclosure (that may incorporate by reference certain limitations and notices imposed by third 
parties).
This equipment complies with Part 68 of FCC Rules. All direct connections to telephone network lines must be made 
using standard plugs and jacks compliant with FCC Part 68. Please note the following:
1. You are required to request service from the telephone company before you connect the unit to a network. When 

you request service, you must provide the telephone company with the following data:
• When you request T1 Service, you must provide the telephone company with

— The Facility Interface Code
Provide the telephone company with all the codes below:
– 04DU9-BN (1.544 MB, D4 framing format)
– 04DU9-DN (1.544 MB, D4 framing format with B8ZF coding)
– 04DU9-1KN (1.544 MB, ESF framing format)
– 04DU9-1SN (1.544 MB, ESF framing format with B8ZF coding)
– 04DU9-1ZN (1.544 MB, ANSI ESF and ZBTSI without line power)
The telephone company will select the code it has available.

— The Service Order Code(s) (SOC): 6.0F
— The required Universal Service Order Code (USOC) jack: RJ48C

• When you request 56K/64K Service, you must provide the telephone company with
— The Facility Interface Code: 04DU5-56/64
— The Service Order Code(s) (SOC): 6.0F
— The required Universal Service Order Code (USOC) jack: RJ48S

• When you request V.34 Service, you must provide the telephone company with
— The required Universal Service Order Code (USOC) jack: RJ11C
— The make, model number, Ringer Equivalence Number (REN), and FCC Registration number of the unit

The REN helps you determine the number of devices you can connect to your telephone line and still have 
all of those devices ring when your number is called. In most, but not all, areas, the sum of the RENs of all 
devices should not exceed 5.0. To be certain of the number of devices you can connect to your line, you 
should call your local telephone company to determine the maximum REN for your calling area. This 
equipment must not be used on party lines or coin lines.

• When you request ISDN “U” Interface Service, you must provide the telephone company with
— The Facility Interface Code: 02IS5
— The Service Order Code(s) (SOC): 6.0F
— The required Universal Service Order Code (USOC) jack: RJ49C

• When you request ISDN “S/T” Interface Service, you must provide the telephone company with
— The Service Order Code(s) (SOC): 6.0N
— The make, model number, and FCC Registration number of the NT1

Note: ISDN S/T cannot be directly connected to the network.
• When you request Primary Rate ISDN Service, you must provide the telephone company with

— The Facility Interface Code: 04DU9-1SN (1.544 MB, ESF framing format with B8ZF coding)
— The Service Order Code(s) (SOC): 6.0F
Network Managers Guide for Symposium TAPI Service Provider for Meridian 1, release 2.3.1
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— The required Universal Service Order Code (USOC) jack: RJ48C
2. Your telephone company may make changes to its facilities, equipment, operations, or procedures that could affect 

the proper functioning of your equipment. The telephone company will notify you in advance of such changes to 
give you an opportunity to maintain uninterrupted telephone service.

3. If the unit causes harm to the telephone network, the telephone company may temporarily discontinue your service. 
If possible, they will notify you in advance, but if advance notice is not practical, you will be notified
as soon as possible and will be informed of your right to file a complaint with the FCC.

4. If you experience trouble with the unit, please contact the Nortel Networks Technical Solutions Center in
your area for service or repairs. Repairs should be performed only by service personnel authorized by 
Nortel Networks. 

North America (800) 4NORTEL or (800) 466-7835
EMEA (33) (4) 92-966-968
Asia Pacific (61) (2) 9927-8800
China (800) 810-5000

5. You are required to notify the telephone company when you disconnect the unit from the network.

Nortel Networks Inc. software license agreement
This Software License Agreement (“License Agreement”) is between you, the end-user (“Customer”) and Nortel 
Networks Corporation and its subsidiaries and affiliates (“Nortel Networks”). PLEASE READ THE FOLLOWING 
CAREFULLY. YOU MUST ACCEPT THESE LICENSE TERMS IN ORDER TO DOWNLOAD AND/OR USE THE 
SOFTWARE. USE OF THE SOFTWARE CONSTITUTES YOUR ACCEPTANCE OF THIS LICENSE 
AGREEMENT. If you do not accept these terms and conditions, return the Software, unused and in the original shipping 
container, within 30 days of purchase to obtain a credit for the full purchase price.
“Software” is owned or licensed by Nortel Networks, its parent or one of its subsidiaries or affiliates, and is copyrighted 
and licensed, not sold. Software consists of machine-readable instructions, its components, data, audio-visual content 
(such as images, text, recordings or pictures) and related licensed materials including all whole or partial copies. Nortel 
Networks grants you a license to use the Software only in the country where you acquired the Software. You obtain no 
rights other than those granted to you under this License Agreement. You are responsible for the selection of the 
Software and for the installation of, use of, and results obtained from the Software.
1. Licensed Use of Software. Nortel Networks grants Customer a nonexclusive license to use a copy of the Software 
on only one machine at any one time or to the extent of the activation or authorized usage level, whichever is applicable. 
To the extent Software is furnished for use with designated hardware or Customer furnished equipment (“CFE”), 
Customer is granted a nonexclusive license to use Software only on such hardware or CFE, as applicable. Software 
contains trade secrets and Customer agrees to treat Software as confidential information using the same care and 
discretion Customer uses with its own similar information that it does not wish to disclose, publish or disseminate. 
Customer will ensure that anyone who uses the Software does so only in compliance with the terms of this Agreement. 
Customer shall not a) use, copy, modify, transfer or distribute the Software except as expressly authorized; b) reverse 
assemble, reverse compile, reverse engineer or otherwise translate the Software; c) create derivative works or 
modifications unless expressly authorized; or d) sublicense, rent or lease the Software. Licensors of intellectual property 
to Nortel Networks are beneficiaries of this provision. Upon termination or breach of the license by Customer or in the 
event designated hardware or CFE is no longer in use, Customer will promptly return the Software to Nortel Networks 
or certify its destruction. Nortel Networks may audit by remote polling or other reasonable means to determine 
Customer’s Software activation or usage levels. If suppliers of third party software included in Software require Nortel 
Networks to include additional or different terms, Customer agrees to abide by such terms provided by Nortel Networks 
with respect to such third party software.
2. Warranty. Except as may be otherwise expressly agreed to in writing between Nortel Networks and Customer, 
Software is provided “AS IS” without any warranties (conditions) of any kind. NORTEL NETWORKS DISCLAIMS 
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ALL WARRANTIES (CONDITIONS) FOR THE SOFTWARE, EITHER EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE AND ANY WARRANTY OF NON-INFRINGEMENT. Nortel Networks is not obligated to 
provide support of any kind for the Software. Some jurisdictions do not allow exclusion of implied warranties, and, in 
such event, the above exclusions may not apply. 
3. Limitation of Remedies. IN NO EVENT SHALL NORTEL NETWORKS OR ITS AGENTS OR SUPPLIERS BE 
LIABLE FOR ANY OF THE FOLLOWING: a) DAMAGES BASED ON ANY THIRD PARTY CLAIM; b) LOSS OF, 
OR DAMAGE TO, CUSTOMER’S RECORDS, FILES OR DATA; OR c) DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL, PUNITIVE, OR CONSEQUENTIAL DAMAGES (INCLUDING LOST PROFITS OR SAVINGS), 
WHETHER IN CONTRACT, TORT OR OTHERWISE (INCLUDING NEGLIGENCE) ARISING OUT OF YOUR 
USE OF THE SOFTWARE, EVEN IF NORTEL NETWORKS, ITS AGENTS OR SUPPLIERS HAVE BEEN 
ADVISED OF THEIR POSSIBILITY. The forgoing limitations of remedies also apply to any developer and/or supplier 
of the Software. Such developer and/or supplier is an intended beneficiary of this Section. Some jurisdictions do not 
allow these limitations or exclusions and, in such event, they may not apply.
4. General

a. If Customer is the United States Government, the following paragraph shall apply: All Nortel Networks 
Software available under this License Agreement is commercial computer software and commercial computer 
software documentation and, in the event Software is licensed for or on behalf of the United States 
Government, the respective rights to the software and software documentation are governed by Nortel 
Networks standard commercial license in accordance with U.S. Federal Regulations at 48 C.F.R. Sections 
12.212 (for non-DoD entities) and 48 C.F.R. 227.7202 (for DoD entities).

b. Customer may terminate the license at any time. Nortel Networks may terminate the license if Customer fails 
to comply with the terms and conditions of this license. In either event, upon termination, Customer must 
either return the Software to Nortel Networks or certify its destruction.

c. Customer is responsible for payment of any taxes, including personal property taxes, resulting from 
Customer’s use of the Software. Customer agrees to comply with all applicable laws including all applicable 
export and import laws and regulations.

d. Neither party may bring an action, regardless of form, more than two years after the cause of the action arose.
e. The terms and conditions of this License Agreement form the complete and exclusive agreement between 

Customer and Nortel Networks.
f. This License Agreement is governed by the laws of the country in which Customer acquires the Software. If 

the Software is acquired in the United States, then this License Agreement is governed by the laws of the state 
of New York.
Network Managers Guide for Symposium TAPI Service Provider for Meridian 1, release 2.3.1
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Preface

This Network Managers Guide provides installation, configuration, upgrading, 
and troubleshooting guidelines for configuring a telephony application 
programming interface (TAPI) server on a Windows NT* or Microsoft* Windows 
2000 platform using Symposium TAPI Service Provider for Meridian 1, release 
2.3.1. 

Before you begin

The Network Managers Guide for Symposium TAPI Service Provider for 
Meridian 1, release 2.3.1, release 2.3.1, is designed to be read by system 
integrators, network managers, and sales engineers who have expert knowledge of 
the following products:

• Meridian 1 switch
• Microsoft TAPI software
• Windows NT server or Microsoft Windows 2000 server

If you are using Symposium TAPI Service Provider for Meridian 1 in a Call 
Center environment, expert knowledge of Symposium Call Center products is 
also a requirement.
Network Managers Guide for Symposium TAPI Service Provider for Meridian 1, release 2.3.1
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Text conventions

This guide uses the following text conventions:

angle brackets (< >) Indicate that you choose the text to enter based on the 
description inside the brackets. Do not type the 
brackets when entering the command.
Example: If the command syntax is
ping <ip_address>, you enter
ping 192.32.10.12

bold Courier text Indicates command names and options and text that 
you need to enter.
Example: Use the dinfo command. 
Example: Enter show ip {alerts|routes}.

braces ({}) Indicate required elements in syntax descriptions where 
there is more than one option. You must choose only 
one of the options. Do not type the braces when 
entering the command.
Example: If the command syntax is
show ip {alerts|routes}, you must enter either
show ip alerts or show ip routes, but not both.

brackets ([ ]) Indicate optional elements in syntax descriptions. Do 
not type the brackets when entering the command.
Example: If the command syntax is
show ip interfaces [-alerts], you can enter
either show ip interfaces or 
show ip interfaces -alerts.

italic text Indicates new terms, book titles, and variables in 
command syntax descriptions. Where a variable is two 
or more words, the words are connected by an 
underscore.
Example: If the command syntax is
show at <valid_route>, valid_route is one
variable and you substitute one value for it.

plain Courier
text

Indicates command syntax and system output, for 
example, prompts and system messages.
Example: Set Trap Monitor Filters
213346-A
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Related publications

For more information about the Symposium TAPI Service Provider, refer to the 
following documents:

• Engineering Guidelines for Symposium TAPI Service Provider for
Meridian 1, release 2.3.1, part number 213345-A

• Release Notes for Symposium TAPI Service Provider for Meridian 1, 
release 2.3.1, part number 213347-A

You can print selected technical manuals and release notes free, directly from the 
Internet. Go to the www.nortelnetworks.com/documentation URL. Find the 
product for which you need documentation. Then locate the specific category and 
model or version for your hardware or software product. Use Adobe* Acrobat 
Reader* to open the manuals and release notes, search for the sections you need, 
and print them on most standard printers. Go to Adobe Systems at the 
www.adobe.com URL to download a free copy of the Adobe Acrobat Reader.

You can purchase selected documentation sets, CDs, and technical publications 
through the Internet at the www1.fatbrain.com/documentation/nortel/ URL.

separator ( > ) Shows menu paths when describing nested menus. 
Example: Protocols > IP identifies the IP sub-menu on 
the Protocols menu. 
Shows overlay when describing Meridian 1 switch 
interface.
Example: > 20 identifies overlay 20 to the Meridian 1 
switch.

vertical line ( | ) Separates choices for command keywords and 
arguments. Enter only one of the choices. Do not type 
the vertical line when entering the command.
Example: If the command syntax is
show ip {alerts|routes}, you enter either
show ip alerts or show ip routes, but not
both.
Network Managers Guide for Symposium TAPI Service Provider for Meridian 1, release 2.3.1
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Chapter 1
Overview

Symposium TAPI Service Provider for Meridian 1, release 2.3.1, uses a 
distributed client/server environment to integrate a telephone on a user’s desktop 
with client and server-based applications. The telephone is physically connected 
to a Meridian 1 PBX switch but is not physically connected to a client PC. You do 
not need any special telephones, connectors, circuit packs, or additional wiring for 
the client PC.

Symposium TAPI SP for Meridian 1 is a full function service provider for the 
Microsoft Telephony Application Programming Interface (TAPI), releases 2.x and 
3.0. Microsoft TAPI provides a set of C-language programming routines that 
support telephony control capabilities for central office switches. 

Symposium TAPI SP software is platform vendor independent (PVI) and can be 
installed on any platform that supports one of the following operating systems:

• Windows NT server, release 4.0, with a minimum of service pack 6a installed
• Microsoft Windows 2000 server, with a minimum of service pack 2 installed

When installed on a server, Symposium TAPI SP supports TAPI-compliant 
applications running on the following client PCs:

• Windows NT workstation
• Microsoft Windows 2000 Professional
• Microsoft Windows ME
• Microsoft Windows 98
• Microsoft WIndows 95
Network Managers Guide for Symposium TAPI Service Provider for Meridian 1, release 2.3.1
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Release 2.3.1 of Symposium TAPI SP integrates with the Meridian 1 switch in 
two distinct ways, depending on the type of TAPI environment required. The 
TAPI environments available are either a call center environment, or a knowledge 
worker environment. In addition, you can add networked TAPI and interactive 
voice response (IVR) features. When you purchase Symposium TAPI Service 
Provider, you can choose from one of the following options:

• call center environment
• direct connect for a knowledge worker environment
• call center environment with networked TAPI and IVR 
• direct connect with networked TAPI and IVR 

Target audience

This document is written for system integrators and network managers who have 
expert knowledge of the following products:

• Meridian 1 switch
• Microsoft TAPI software
• Windows NT server or Microsoft Windows 2000 server

Note: Symposium TAPI SP, release 2.3.1, also supports the legacy 
Meridian Link Module. For information about upgrading to Symposium 
TAPI SP, release 2.3.1, in this environment, refer to your Meridian Link 
Module documentation, and to the Network Manager's Guide Reference 
Guide for Installing, Configuring, and Maintaining the Symposium TAPI 
Service Provider for Meridian 1 Release 2.3, which you can download 
from http://www.nortelnetworks.com.

Warning: Symposium TAPI Service Provider for Meridian 1 provides an 
interface between a Meridian 1 system and Microsoft TAPI services. 
Ultimate responsibility for the TAPI environment rests with Microsoft. 
For information refer to http://www.microsoft.com.
213346-A

http://www.microsoft.com
http://www.microsoft.com
http://www.microsoft.com
http://www.nortelnetworks.com
http://www.nortelnetworks.com


Chapter 1 Overview 25

 

If Symposium TAPI Service Provider for Meridian 1 is to be used in a call center 
environment, expert of knowledge of Symposium Call Center products is also a 
requirement.

Do not attempt to install or configure Symposium TAPI SP unless you have 
received accredited training in Symposium TAPI Service Provider.

Symposium TAPI SP architecture options

Symposium TAPI SP is a flexible application that enables a Meridian 1 switch to 
integrate with Microsoft TAPI services. In a call center the service provider 
delivers TAPI capabilities within a skill-based routing (SBR) environment. In a 
knowledge worker environment where automatic call distribution (ACD) routing 
is sufficient, Symposium TAPI SP delivers TAPI capabilities through a direct 
connection with the Meridian 1 switch. The optional networked TAPI/IVR feature 
supports networked skill-based routing (NSBR) and network ACD (NACD) in a 
call center environment, or NACD only in a knowledge worker environment.

Call center environment

In a call center Symposium TAPI Service Provider monitors TAPI ports on the 
Meridian 1 switch and passes information such as automatic number 
identification/dialed number identification service (ANI/DNIS) and calling line 
identification (CLID) to a TAPI-compliant application on a client PC, via the 
Microsoft TAPI server. The TAPI application on the client PC presents this 
information to the agent, perhaps in the form of a screenpop. If you install an IVR 
system in a call center, Symposium TAPI SP uses similar processes to present 
caller entered data (CED), such as customer account number, to an agent. This 
section provides an overview of a call center implementation without IVR. Refer 
to Chapter 6, “Networked TAPI/IVR,” on page 129 for information about 
networked TAPI and IVR in a call center.

In a call center environment, Symposium TAPI SP connects to a Meridian 1 
switch via the Meridian Link Services application that is installed on the 
Symposium Call Center Server (SCCS). (Figure 1)
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Figure 1   TAPI architecture in a call center environment

The SCCS provides skill-based routing and call center reporting services. 
Symposium TAPI SP adds computer telephony integration (CTI) features within 
this environment. To support installations served by the SCCS, Symposium TAPI 
SP links with the Meridian 1 switch via the Meridian Link Services application 
that is resident on the SCCS. 

All Meridian 1 switches use a private, embedded LAN (E-LAN) to isolate 
Meridian system traffic from the customer local area network (C-LAN). In a call 
center, the SCCS is configured as a member of both the E-LAN and the C-LAN 
via separate 10/100BASE-T Ethernet ports on the serve. This configuration 
maintinas the isolation between telephony and data traffic. The TAPI server has 
one 10/100 BASE-T Ethernet connection to the C-LAN, and communicates with 
the E-LAN via a direct connection to the SCCS. 

Note: This document provides guidelines for a TAPI implementation 
with the SCCS. Where fewer agents are required, Symposium TAPI 
Service Provider can deliver TAPI services via the Symposium Express 
Call Center (SECC). 
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Knowledge worker environment

Where ACD routing is not required you can configure a direct connection from 
Symposium TAPI SP to the Meridian 1 switch. Symposium TAPI Service 
Provider monitors TAPI ports on the Meridian 1 switch and passes information 
such as ANI/DNIS and CLID to a TAPI-compliant application on the client PC, 
via the Microsoft TAPI server. The TAPI client presents this information to the 
agent, for example in the form of a screenpop. This section provides an overview 
of an implementation in a knowledge worker environment.

In a knowledge worker environment Symposium TAPI SP connects directly to a 
Meridian 1 switch via a TCP/IP Ethernet connection. (Figure 2)

Figure 2   TAPI direct connection architecture 

With a direct connection implementation a single Meridian 1 switch can support a 
maximum of sixteen TAPI servers. 
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Networked TAPI and IVR

Symposium TAPI SP provides server-to-server networking over LAN or WAN. 
The service provider has an open interface through which it can obtain 
information collected by IVR systems. IVR information is passed to 
TAPI-compliant applications using the standard TAPI interface. (Figure 3)

Figure 3   TAPI system architecture supporting IVR functionality

Symposium TAPI Service Provider works transparently with multiple Windows 
NT or Microsoft Windows 2000 servers. This environment is commonly used for 
NACD with a default of 512 bytes passed with a call locally or between servers in 
a NACD configuration.
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Microsoft TAPI server and client

The Microsoft TAPI Server (TAPISRV) is a server service that can be accessed by 
clients via the MS remote service provider (RSP). On client PCs, access to the 
TAPISRV is provided by installing the Microsoft Windows remote service 
provider (RSP) telephony module. This module routes TAPI requests to a specific 
TAPI service provider. 

TAPI-compliant applications on client PCs issue TAPI messages. TAPISRV 
communicates with the client via the LAN over a TCP/IP Ethernet connection. 
TAPISRV routes TAPI messages from TAPI-compliant applications on the client 
to Symposium TAPI SP on the TAPI server. Symposium TAPI SP converts TAPI 
messages to corresponding switch messages through the Meridian Link Services 
application installed on an SCCS, or via a direct Ethernet connection to the 
Meridian 1 switch. Symposium TAPI SP also converts Meridian 1 switch 
messages to TAPI messages for routing to client applications via TAPISRV.

Meridian Link Services

Meridian Link Services enables an application in a host computer to use the call 
control and call monitoring functions of a Meridian 1 system. Symposium TAPI 
Service Provider extends these capabilities to TAPI-compliant applications 
running on client PCs in a local area network (LAN) using TCP/IP on a 
10/100BASE-T Ethernet connection. 

Configuration and maintenance

Symposium TAPI SP includes a configuration application that provides two 
configuration methods: automatic configuration or manual configuration.

Automatic configuration translates database tables from overlays 20, 21, and 23 
on the Meridian 1 switch and enters this information into the Symposium TAPI 
Service Provider database tables. The configuration application displays this 
information in dialog boxes for viewing and maintenance. 
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Manual configuration is necessary for instances where it becomes necessary to 
add, delete, or modify database information,. Manual configuration enables you to 
alter the database tables through changing fields in relevant configuration dialog 
boxes. 

FlexLM License Manager

The FlexLM License Manager application allows you to configure the license 
manager server and the license file that you received when you purchased 
Symposium TAPI Service Provider. The license file is necessary for Symposium 
TAPI Service Provider to work. The license file allows TAPI applications to 
simultaneously monitor and control a maximum of 1,200 DNs. 

Features of Symposium TAPI SP 

Symposium TAPI Service Provider for Meridian 1, release 2.3.1, supports a wide 
range of features, including the following:

• basic call control
• enhanced call control 
• automatic call distribution,
• outbound trunk monitoring 
• predictive dialing applications
• IVR

Basic call control

The basic call control features that Symposium TAPI SP supports include:

• make call
• answer call
• release call
• hold call
• unhold call
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• conference call (three party)
• transfer call

— blind transfer
— supervised transfer

• monitoring of call events

Enhanced call control

The enhanced call control features that Symposium TAPI SP supports include:

• swap hold
• caller destination number (CDN) treatments 

— ringback
— busy
— silence
— music

Automatic call distribution

Symposium TAPI SP supports software-based distribution of calls using these 
ACD features:

• setting up one main number and distributing the calls to a group of agents
• setting up a supervisor position for an ACD group
• monitoring the quality of the service being provided to incoming callers
• gathering information on the calls such as, hold time, time in queue, and the 

number of agents logged in a queue.

ACD proxy service

The ACD proxy service, which is a separate ACD application provided with 
Symposium TAPI SP, allows agents to do the following:

Note: CDN treatments are not supported in a knowledge worker 
environment which is based on a direct connection.
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• log in/log out
• ready/not ready
• walkaway/return 
• call forward/cancel call forward
• make set busy
• make set in service

The ACD proxy service also registers ACD queue numbers so that an agent can 
log in to an ACD queue without launching an application.

Agent walkaway feature

The agent walkaway feature works in the following ways:

• To walkaway with a current call, an active agent does the following:
— presses the hold key
— unplugs the headset
— walks away

The logger application displays a walkaway message for that agent position. 
When the agent returns and plugs back into the set, the logger application 
displays a return message for that agent position.

• To walkaway with a current call, a non-active agent does the following:
— places the phone in the not-ready state
— presses the hold key
— unplugs the headset
— walks away

The logger application displays a walkaway message for that agent position. 
When the agent returns and plugs back into the set, the logger application 
displays a return message for that agent position. This action allows the agent 
to enter the not-ready state without disconnecting.

Telephone set control

You can manipulate a telephone set using the following features:
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• call forwarding
• message waiting indicator
• device validation
• event management

Outbound and predictive dialing applications

Symposium TAPI SP supports outbound and predictive dialing applications from 
third parties that use the TAPI Service Provider interface for call control and 
monitoring. Outbound and predictive dialing applications and tools are used in 
call centers to perform telemarketing, collections, telesales, and account 
management.

Trunk monitoring 

The trunk monitoring feature allows Symposium TAPI SP to process the link 
messages for inbound calls on a monitored trunk. The application can use trunk 
information to record conversation on incoming calls.

Interactive voice response 

Symposium TAPI SP provides call data support for inbound calls transferred from 
the Nortel Networks Periphonics IVR system or third-party systems running on 
ports that are monitored by Symposium TAPI Service Provider. The service 
provider also provides network call data support for calls overflowed from other 
remote Meridian 1 switches controlled by Symposium TAPI Service Provider.

The IVR to TAPI server interface consists of a core set of software applications 
and a per port license. All IVR ports must be licensed individually. 

Security features

FlexLM License Manager, supplied by GLOBEtrotter Software Inc., is provided 
with Symposium TAPI SP to manage your software license file. A physical 
security feature that connects to the server by a 25-pin D-type parallel port is also 
provided. The service provider will not operate unless both the software license 
and physical security device are installed and configured correctly. 
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Auto link recovery feature

The auto link recovery feature monitors the link status between Symposium TAPI 
SP and the link protocol on the Meridian 1 switch. If link loss is detected the 
service provider tries to reestablish the link and revalidates the link status.

To enable the auto link recovery feature on the Meridian 1 switch in a call center 
environment, you must set the polling interval for the switch-to-host protocol to a 
value greater than zero. For information, refer to “Configuring the Meridian 1 
Host table” on page 95. In a knowledge worker environment which uses a direct 
connection TAPI architecture, auto link recovery is the default setting.

Dynamic database feature

Symposium TAPI Service Provider, release 2.3.x, allows run time updates from 
the Symposium configuration application to the TAPI server. Modifications, such 
as addition or deletion of controllable telephone sets and their call control 
supported features are reported immediately to Symposium TAPI SP during run 
time.

Administration features

A range of administration features is available for Symposium TAPI SP.

Symposium configuration application

In the Symposium configuration application you can enter information into the 
Symposium TAPI SP database tables and maintain this information. These tables 
include entries for controllable telephone sets and related call control features.

Logger application

In the event of problems, you can use the logger tool to trace application activities. 
During a troubleshooting session, the logger application writes status and error 
messages (as defined on the configuration dialog boxes) to the scrollable logger 
window. When the logger window is full, the logger application writes status and 
error messages to a logger overflow file. You can save the information in the 
logger overflow file to use for diagnostic and troubleshooting purposes. You can 
also print a complete file, or highlighted sections.
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License Manager troubleshooting tools 

The following tools assist you in troubleshooting the FlexLM License Manager:

• SADDBMON is a console debug monitor application that displays error 
information describing the cause of failure.

• debug.log is log file written by FlexLM License Manager with status 
information and an error log in case of failure.

Microsoft TAPI browser application

The Microsoft TAPI browser appplication enables you to verify that Symposium 
TAPI SP is installed and configured properly and is operating correctly. This 
feature is applicable only in a call center configuration and is not supported in a 
direct connect knowledge worker configuration.

Symposium TAPI SP feature interactions

Users of TAPI-compliant applications must be aware of feature interactions with 
Symposium TAPI SP. 

Feature interactions in a call center environment

When running TAPI-compliant applications with Symposium TAPI SP using 
Meridian Link Services on the SCCS, the following features are not available:

• not-ready with optional disconnect. An application invokes the not-ready 
status for a set without disconnecting the call

• enhanced time stamp IE. This feature is used in status change
• set feature notification messages for:

— ready/not-ready
— log in/log out
— walk away/return
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Feature interactions in a knowledge worker environment

The following features are not supported in a knowledge worker environment 
with a direct connection architecture:

• CDN treatments/call routing features 
• CDN call model 

Feature interactions in all environments

The following feature interactions apply in all implementations of Symposium 
TAPI SP:

• Symposium TAPI SP does not support multiple users placing a call on hold. If 
a Symposium TAPI SP application station calls another Symposium TAPI SP 
application station, only one user can put the call on hold.

• Symposium TAPI SP supports analog telephone sets in a different way from 
digital telephone sets. If you use analog telephone sets, be aware of the 
following:
— Symposium TAPI SP does not recognize call activity associated with an 

analog telephone’s directory number if a call to an analog ACD set is 
abandoned.

— Symposium TAPI SP does not support a TAPI-compliant application 
answering calls for analog sets; users of analog sets must lift the handset 
or otherwise cause the line to go off hook to answer calls.

— Symposium TAPI SP supports a TAPI-compliant application hanging up 
the telephone of an analog set but the handset must be returned to the 
cradle before it is picked up again.

• Symposium TAPI SP offers limited support for multiple appearance directory 
numbers (MADNs).

• Symposium TAPI SP does not display the called number (when dialing from a 
telephone set) until the called party answers.

• Symposium TAPI SP does not support multiple call ring (MCR) and multiple 
call no ring (MCN) features.

• Symposium TAPI SP does not support speed dial feature access codes.
• Symposium TAPI SP does not recognize the DNs of callers that hang up 

during a supervised transfer or conference call.
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• Symposium TAPI SP does not recognize calls that have been manually 
transferred from a telephone set not configured with the associated set (AST) 
feature.

• Symposium TAPI SP does not support the group call feature.

Feature interactions with other software applications

Symposium TAPI SP is compatible with a range of software applications, 
including Nortel Networks Symposium Agent. Refer to the user documentation 
provided with these products for detailed information. Refer to the Engineering 
Guide for Symposium TAPI Service Provider for Meridian 1, release 2.3.1, part 
number 213345-A, for information about supported software.

Networking between Symposium TAPI Service Providers

The Meridian 1 switch supports call routing between a network of Meridian 1 
switches over ISDN trunks using network automatic call distribution (NACD). 
This functionality ensures that Symposium TAPI SP can track call data 
consistently and reliably for calls that overflow from one Meridian 1 switch to 
another.

On demand call data

When a call is offered to an agent, it contains the calling line identification (CLID) 
of the local Meridian 1 switch. When a call is overflowed through NACD to a 
remote switch, the following identifiers are used:

• the CLID of the switch that received the overflowed call
• the network CLID for the remote switch that overflowed the call, containing 

two elements:
— the CLID for the remote switch
— the home location code (HLOC) for that switch
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Symposium TAPI SP extracts the HLOC from the network CLID and searches the 
IVR host database table to locate the IP address of the TAPI server at the site 
associated with this HLOC. The IVR host database table is configured during 
initialization and contains the HLOC and corresponding IP address of all 
participating TAPI servers in network. When an IP address is found, Symposium 
TAPI SP sends a TCP/IP message requesting call data for the network CLID to the 
remote Symposium TAPI server. 

Call data networking requirements

The requirements for call data networking are as follows:

• All switches must be on an ISDN trunk.
• The NACD application must be installed on the Meridian 1 switch.
• Each switch must have a unique HLOC.
• To communicate with each other, all Symposium TAPI servers must be 

running release 2.2 or higher of the service provider software.
• All servers must be visible over TCP/IP, which should be verified by pings.
• Symposium TAPI SP must have the TAPI_IVR_feature option on the 

supplied license file.

Restriction for NACD overflow and call data 

Network call data works only if the call comes from another agent via another 
Meridian 1 switch. The destination of the call can be either an ACD queue or a 
CDN. 
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Chapter 2
Installation guidelines

Before you install Symposium TAPI Service Provider for Meridian 1, release 
2.3.1, you must prepare the TAPI environment. This chapter provides the 
following information:

• prerequisites
• how to configure local area networks
• how to install Symposium TAPI SP in a knowledge worker (direct connect) 

environment
• how to install Symposium TAPI SP in a call center

The information in this chapter refers to a first-time installation of Symposium 
TAPI SP. If you want to upgrade to release 2.3.1 from an earlier release of the 
software, refer to Chapter 5, “Upgrading Symposium TAPI SP,” on page 117. If 
you want to install Symposium TAPI SP with a legacy system such as the 
Meridian Link Module, refer to the following:

• the product documentation you received with the Meridian Link Module 
• Network Managers Guide, a Reference Guide for Installing, Configuring, and 

Maintaining Symposium TAPI Service Provider for Meridian 1, release 2.3, 
which is available on the Nortel Networks Website at
http://www.nortelnetworks.com. 

Note: This document highlights requirements that are specific to the 
operation of Symposium TAPI SP. It does not provide installation and 
configuration guidelines for dependent products. It is assumed that 
dependent products are installed and configured by qualified engineers.
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General prerequisites

Before you commence installation, refer to the Engineering Guidelines for 
Symposium TAPI Service Provider for Meridian 1, part number 213345-A, which 
outlines the minimum hardware and software requirements for the TAPI server. 
This section provides the following information:

• how to prepare the TAPI server
• how to prepare the Meridian 1 switch 
• how to install the security device
• how to configure local area networks

Preparing the TAPI server

Symposium TAPI Service Provider is platform vendor independent (PVI) and can 
be installed on any system that runs one of the following operating systems:

• Windows NT server, release 4.0, with a minimum of service pack 6a installed
• Microsoft Windows 2000 server, with a minimum of service pack 2 installed

Nortel Networks recommends that you allocate a dedicated server for TAPI 
activities.

Refer to Engineering Guidelines for Symposium TAPI Service Provider for 
Meridian 1, part number 213345-A for detailed specifications for the hardware 
and software requirements for the TAPI server. You must comply with these 
specifications, and note the following requirements if you plan to install 
Symposium TAPI SP on a Windows NT server:

• Do not use a beta release of Windows NT server software.
• The required service pack is not supplied with Symposium TAPI SP and must 

be downloaded from the Microsoft Website at http://www.microsoft.com. A 
readme.txt file provided with Microsoft TAPI software provides information 
about installing the service pack.

Note: You can perform a network installation of Symposium TAPI SP. 
To do so, you must enter the network address of the destination server 
before performing the installation.
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• The Windows NT service pack includes an upgrade to Microsoft TAPI 
software. When you install the service pack, do not install Microsoft TAPI 
software afterwards because this can cause unexpected behavior in 
Symposium TAPI SP.

Preparing the Meridian 1 switch

Before the Meridian 1 switch can support TAPI operations, a number of Meridian 
applications must be installed on the switch. Depending on the type of capability 
required, a range of additional applications can also be installed.

Required applications

Table 1 lists the applications that must be installed on a Meridian 1 switch in order 
to support Symposium TAPI SP in either a call center (SCCS) or knowledge 
worker (direct connect) environment.

Note: You can install Symposium TAPI SP, release 2.3.1, with a 
Succession CSE1000 switch in place of a Meridian 1 switch. The same 
installation and configuration guidelines apply.

Table 1   Required Meridian 1 applications 

Application 
(Option) Purpose SCCS Direct connect

35 Integrated messaging (IMS) X X

77 Command and status link (CSL) X X

153 ISDN/AP for third parties (IAP3P) X

247 Call ID X

311 NGCC mixed generation call center X

324 NGEN new generation foundation X
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Optional applications

Table 2 lists additional applications that can be installed, depending on the level of 
TAPI functionality required.

Installing the security device

A security device is provided with Symposium TAPI SP. The software will not run 
until you install the device on the TAPI server, Symposium TAPI SP will not run. 

The security device has a 25-pin connector, labeled “computer” at one end. Attach 
this connector to any parallel port on the TAPI server, and tighten the screws 
firmly to ensure that the device is securely connected to the port. If a printer is 
connected to the computer, attach a shielded printer cable to the outside connector 
of the security device. If multiple security devices are attached to the parallel port, 
the Symposium TAPI SP device must be the first one attached directly to the port.

If the computer is close to a wall or another obstacle, attach an extension cable to 
a parallel port and attach the security device to this extension cable. Use a straight 
through DB-25 male to DB-25 female extension cable.

Table 2   Optional Meridian 1 applications 

Application 
(Option) Purpose

40 Basic ACD 

41 Basic ACD B

42 Basic ACD 3 usage reports

43 Basic ACD C2 load management

45 Basic ACD A

50 ACD D used for ACD MAX applications

145 Integrated services digital network (ISDN)

146 Primary rate access (PRA)

214 Enhanced ACD routing (EAR)

215 Customer controlled routing (CCR)
213346-A



Chapter 2 Installation guidelines 43

 

Configuring local area networks

All Meridian 1 switches use a Meridian 1 embedded LAN (E-LAN) for system 
access and control. In a TAPI environment it is necessary to isolate telephony 
traffic from data traffic. Telephony traffic is confined to the E-LAN and data 
traffic travels on a separate LAN, the customer LAN (C-LAN) or C-LANs. To 
ensure that telephony traffic is isolated from data traffic, the following network 
interfaces are required:

• In a knowledge worker environment, the TAPI server requires two 10/
100BASE-T network Ethernet ports, one connecting to the E-LAN and the 
other connecting to the C-LAN.

• In a call center environment, the TAPI server requires one 10BASE-T 
network Ethernet port to connect to the C-LAN. A direct connection to the 
SCCS provides a link to the E-LAN.

An additional C-LAN is required in a call center environment to ensure that 
Symposium TAPI SP traffic is not affected by non-TAPI data traffic. An Ethernet 
switch or router is installed to provide routing between these C-LANs.

Configuring the E-LAN

If you are installing Symposium TAPI SP in an existing Meridian 1 environment 
the E-LAN configuration will be in place. If the installation is in a new 
environment, it is necessary to configure the E-LAN on the Meridian 1 switch. 

Applications connect to the E-LAN using the IP address of the Ethernet port on 
the Meridian 1 switch and port number 8888. The switch dynamically assigns the 
appropriate E-LAN address for each application. 

There are two elements in configuring the E-LAN: hardware configuration of the 
Ethernet port on the switch and the software configuration. Refer to the product 
documentation provided with your Meridian 1 switch for instructions on hardware 
configuration. When you complete the hardware configuration of the Ethernet 
port, perform the software configurations described in the following sections.
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Assigning an IP address for the Meridian 1 switch

To assign an IP address for an Ethernet port, log on to the Meridian 1 switch 
through Optivity Telephony Manager (OTM). Use the following sample as a 
template, substituting relevant values where appropriate in overlay 117:

> LD 117

NEW HOST M1SERVER_A 47.1.1.10
where M1SERVER_A is the host name for the IP address
and 47.1.1.10 is the IP address of the active Ethernet port
CHG ELNK ACTIVE M1SERVER_A
CHG MASK 255.255.255.0
where 255.255.255.0 is the local subnet mask

In a redundant system, with a dual CPU, repeat this process for the backup, 
inactive CPU, using the following template and substituting appropriate values 
where necessary: 

> LD 117

NEW HOST M1SERVER_B 47.1.1.11
where M1SERVER _B is the host name for the IP address
and 47.1.1.11 is the IP address of the standby Ethernet port
CHG ELNK INACTIVE M1SERVER_B

After you assign the necessary IP address(es), press the <MAN INT> button on 
the CPU card to manually initialize the system and activate the new IP address 
information.

Defining a routing table

The routing table supplies the Meridian 1 switch with the IP addresses of a 
gateway server. This information allows the switch to send return messages to the 
gateway for forwarding to the requesting client. If you have a default gateway in 
the network, use the following sample as a template, substituting relevant values 
where appropriate:

> LD 117
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NEW ROUT 0.0.0.0 47.1.1.250
where 47.1.1.250 is the IP address of the default gateway

Primary IP address procedures

This section provides procedures for the activation, validation, and recovery of the 
Primary IP address.

Activation procedure

Manually initialize the system to activate the connection to the IP address 
configured in overlay 117.

Validation procedure

To verify that the primary IP address is active, compare the IP address configured 
in overlay 117 with the IP address used in overlay 137. The IP addresses must be 
identical in both overlays To perform the validation, use the following sample as a 
template, substituting relevant values where appropriate:

> LD 117<cr>

OAM000
PRT ELNK<cr>
ACTIVE ETHERNET: PRIMARY_IP 47.48.49.50
INACTIVE ETHERNET: SECONDARY_IP 47.48.49.51
OK

> LD 137 <cr>

CIOD000
STAT ELNK<cr>
ELNK ENABLED
Ethernet (ln unit number 0):
Host: PRIMARY_IP Internet address: 47.48.49.50

Note: You must perform a manual initialization to establish the initial 
connection to the primary IP address. After the connection is established, 
another manual initialization is required only if the primary IP address is 
changed.
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where 47.48.49.50 indicates the actual IP address used
Broadcast address: 47.48.49.255
Ethernet address: 00:00:75:32:1e:ca
Netmask: 0xff000000; Subnetmask: 0xfffff000
33520 packets received; 12308 packets sent
0 input errors; 0 output errors
0 collisions

If the IP addresses are not identical, the IP address is invalid and it is necessary to 
perform the recovery procedure. 

Recovery procedure

If the connection to the Primary IP address is lost, it can be reestablished by 
performing the following tasks:

1 Manually initialize the system to reestablish a connection to the primary IP 
address.

2 Perform the validation procedure again to confirm the Ethernet connection is 
fully functional.
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Installation notes for a knowledge worker environment

In a knowledge worker environment, where skill-based routing is not required, a 
direct connect configuration is used (Figure 4). 

Figure 4   Direct connect installation for a knowledge worker environment

Before you proceed, ensure that the prerequisites described earlier in this chapter 
are met. The following requirements are also necessary:

• You must have administrative rights and be familiar with Microsoft TAPI 
operation to install this software. 

• TCP/IP must be configured and operational on both the Meridian 1 host link 
and on the TAPI server.
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Installing Symposium TAPI SP software

To install Symposium TAPI SP on the TAPI server, perform the following tasks:

1 Log on to the TAPI server.

2 Insert the Symposium TAPI Service Provider CD into the CD drive.

3 Select Start > Run.

4 Type the drive\setup.exe. For example, e:\setup.exe. Alternatively, in the 
Windows Explorer window, select the drive and navigate to the setup.exe file.

5 Select the setup.exe file to launch the wizard-driven installation application.

6 In the welcome window, click Next to display the software license agreement 
window.

7 Click Yes to indicate that you accept the terms of the software license 
agreement before proceeding to the destination location window.

8 Click on Next to continue with the installation process. If you wish to cancel 
the installation at any point, click Cancel on any of the installation windows.

Note: Before you install Symposium TAPI SP, close any TAPI 
application running on the server or client. 
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9 The installation application issues a notification if it detects a previous release 
of Symposium TAPI SP (Figure 5). If this occurs, refer to Chapter 5, 
“Upgrading Symposium TAPI SP,” on page 117, for further information.

Figure 5   Detecting a previous release
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If no previous release is detected, the Setup Type window opens (Figure 6). Select 
the setup type you prefer and click Next.

Figure 6   Setup Type window
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10 In the TAPI server type window (Figure 7), select direct connect and click 
Next.

Figure 7   TAPI server type window

11 The installation application copies the required files to the specified directory. 
A status window displays installation progress.

12 When the copying is complete, the setup application automatically configures 
the software license. If it cannot locate the license file, you are prompted to 
provide an alternative path to the license file. Symposium TAPI SP will not 
operate without the license file. Click Yes to locate it.
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13 In the select folder for license file window, navigate to the location of the file. 
The setup application configures the license file before presenting the 
InstallShield Wizard complete window (Figure 8).

Figure 8   InstallShield Wizard Complete window

14 Click Yes I want to view the ReadMe File to display the Readme.txt file. This 
file includes valuable information on Symposium TAPI Service Provider for 
Meridian 1, release 2.3.1. Nortel Networks recommends that you read this file 
before configuring and using the software.

15 Click Finish to complete the installation.
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Installation notes in a call center environment

This section describes the procedures to install Symposium TAPI SP in a call 
center environment with the Symposium Call Center Server (Figure 9). The same 
procedures apply if you are installing Symposium TAPI SP in a call center 
environment with Symposium Express Call Center. Two 10/100BASE-T network 
Ethernet ports are required on the SCCS to ensure physical isolation between the 
E-LAN and the C-LANs. Only one 10/100BASE-T network Ethernet port is 
necessary on the TAPI server to connect to the C-LAN.

Figure 9   SCCS installation in a call center environment

Before you proceed, ensure that the prerequisites described earlier in this chapter 
are met. The following requirements are also necessary:

• You must have administrative rights and be familiar with Microsoft TAPI 
operation to install this software. 

• TCP/IP must be configured and operational on both the Meridian 1 host link 
and on the TAPI server.
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Preparing a Symposium Call Center Server

In a Symposium Call Center Server (SCCS) environment, Symposium TAPI SP 
integrates with the Meridian 1 switch through Meridian Link Services on the 
SCCS. Meridian Link Services is supplied with the SCCS software and 
communicates with the TAPI server over an Ethernet connection, using the TCP/
IP protocol. Meridian Link Services communicates with the Meridian 1 switch 
over a second Ethernet connection using the TCP/IP protocol.

Prerequisites

To prepare the SCCS for TAPI operations, verify the following:

• the SCCS is fully functioning with all user IDs and passwords properly 
configured

• the necessary telephone user ID’s and passwords are configured if the SCCS 
is used for skill-based routing

• the TAPI server is connected on the C-LAN
• Meridian Link Services is running on the SCCS server
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Configuring an isolated C-LAN for TAPI traffic

If there is heavy traffic on the C-LAN, certain Symposium TAPI SP real-time 
activities, such as window-pops, can operate incorrectly. To restrict data traffic 
reaching Symposium TAPI SP, create an isolated C-LAN dedicated to 
TAPI-related traffic (Figure 10). 

Figure 10   Isolating TAPI-traffic on a separate C-LAN

In a multiple C-LAN configuration, traffic is isolated on the following LANs:

• Traffic between the Meridian 1 switch and the SCCS is isolated on the 
E-LAN.

• Traffic between the SCCS and Symposium TAPI SP is isolated on its own, 
dedicated C-LAN. If an IVR system is installed, IVR traffic is also confined 
to this C-LAN.

• Data traffic between client PCs and data servers is isolated on the main 
C-LAN.

Install a router or Ethernet switch to provide routing between C-LANs.
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Installing Symposium TAPI SP software

To install Symposium TAPI SP on the TAPI server, perform the following tasks:

1 Log on to the TAPI server.

2 Insert the Symposium TAPI Service Provider CD into the CD drive.

3 Select Start > Run.

4 Type the drive\setup.exe, for example, e:\setup.exe. Alternatively, in the 
Windows Explorer window, select the drive icon and navigate to the setup.exe 
file. 

5 Click the setup.exe file to start the wizard-driven installation application.

6 In the welcome window click Next to display the software license agreement.

7 Click Yes to indicate that you accept the terms of the software license 

8 Click Next to continue with the installation. If you wish to cancel the 
installation at any point, click Cancel on any of the installation windows.

Note: Before you install Symposium TAPI SP, close any TAPI 
application running on the server or client. 
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9 The installation application issues a notification if it detects a previous release 
of Symposium TAPI SP (Figure 11). If this occurs, refer to Chapter 5, 
“Upgrading Symposium TAPI SP,” on page 117, for further information.

Figure 11   Detecting a previous release
Network Managers Guide for Symposium TAPI Service Provider for Meridian 1, release 2.3.1



58 Chapter 2 Installation guidelines

 

10 Assuming that no previous release is detected, the Setup Type window opens 
(Figure 12). Select the setup type you prefer and click Next.

Figure 12   Setup Type window
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11 In the TAPI server type window that opens (Figure 13), select the 
Meridian Link/SCCS server option and click Next.

Figure 13   TAPI server type window

12 The installation application copies the required files to the specified directory. 
A status window displays installation progress.

13 When the copying is complete, the set up application automatically configures 
the software license. If it cannot locate the license file, you are prompted to 
provide an alternative path to the license file. Symposium TAPI SP cannot 
operate without the license file. Click Yes if you wish to locate the license file.
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14 In the select folder for license file window, navigate to the location of the 
license file. The setup application configures the license file before displaying 
the InstallShield Wizard Complete window (Figure 14).

Figure 14   InstallShield wizard complete window

15 Click Yes I want to view the ReadMe File to display the readme.txt file. This 
file includes valuable information on Symposium TAPI Service Provider for 
Meridian 1, release 2.3.1. Nortel Networks recommends that you read this file 
before configuring and using the software.

16 Click Finish to complete the installation.

Configuring the FlexLM License Manager

The FlexLM License Manager is provided with Symposium TAPI SP to manage 
your software license. When you install Symposium TAPI SP it automatically 
loads your software license file. Before configuring Symposium TAPI SP, you 
must configure your software license file with the name of your TAPI server:
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1 Select Start > Programs > Nortel > Nortel Symposium TAPI Service Provider 
for Meridian 1 > FlexLM License Manager.

2 Click the Licenses tab; then click Show License file. (Figure 15)

Figure 15   Licenses window in the FlexLM License Manager

3 The license file (which opens in Notepad) contains a number of lines of 
information. Change the entry in the first line to reflect your server name. 
(Figure 16)

Figure 16   Sample license file

4 Select File > Save to save the changes and exit the application.

Caution: Do not change any other information in this file. If you change 
other information, you invalidate your license.
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Chapter 3
Preparing the TAPI environment

This chapter provides information about preparing the TAPI environment, 
including the following sections:

• TAPI server domains
• Configuring Microsoft TAPI for Symposium TAPI SP

Microsoft TAPI terminology

Before you begin, familiarize yourself with the following Microsoft TAPI terms:

• remote — TAPI remote service provider (remotesp.tsp)
• client machine — the machine using the remote service provider
• client machine domain — the domain to which the client machine belongs 

This information is only relevant if the client is a Windows NT machine.
• client user — the domain user logged onto the client machine
• client domain — the domain to which the client user (TAPI client) belongs
• server machine — the Windows NT or Microsoft Windows 2000 telephony 

server machine 
• server machine domain — the machine domain to which the telephony server 

belongs
• server service — the telephony service running on the telephony server, which 

is also called service, telephony service, or server 
• server user — the domain account towhich the telephony server service 

belongs, for example TAPIAdmin 
• server user domain — the user domain to which the server user belongs
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TAPI server domains

Symposium TAPI SP requires that all TAPI clients log in through a domain. A 
domain is a windows networking concept designed to facilitate the administration 
and security of network resources on Windows NT and Microsoft Windows 2000 
servers. Where multiple servers are required in a network, a domain server 
provides centralized management of all user account information. Users only log 
on to one server rather than multiple servers. Domains combine the features of 
workgroups and directories, allowing users to access resources on multiple 
servers within a centralized management structure. In large networks you can 
create multiple domains and you establish trust relationships between domains to 
provide users with access to resources on other domains.

Before you configure TAPI domains, you must be familiar with the concepts and 
procedures for domain management provided by Microsoft. For information use 
the search facility at http://www.microsoft.com.

Windows NT domain architecture

You can designate a Windows NT server as one of the following:

• primary domain controller (PDC)
• backup domain controller (BDC)
• member or standalone server

When you install a Windows NT server you are prompted to select one of these 
options. When you designate a server as a PDC, a domain is created 
automatically. The PDC maintains the security account management (SAM) 
database, which is the only read/write copy of the master database for the domain. 
If users cannot access the PDC, they cannot log on to the network. Therefore, you 
must designate at least one other server as a BDC per domain. At regular intervals, 
the PDC circulates read-only copies of the SAM database to all BDCs in the 
domain. If the PDC is unavailable, users can log on through a BDC but the BDC 
cannot update account information. You can designate the BDC to become the 
acting PDC if necessary, for example, in the event of server failure.

Alternatively, you can designate a server as a member (standalone) server in a 
domain. A standalone server has access to all resources for the domain without 
any responsibility for security management.
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The SAM database resides in server RAM. Microsoft recommends that you do not 
allow the SAM database to exceed 40MB in size. In a large network, multiple 
domains allow you to spread the logon processing requirements over a number of 
PDC and BDC servers. 

Microsoft Windows 2000 domain architecture

Domain structures are different on a Microsoft Windows 2000 network, which 
uses the active directory architecture for domain management. The active 
directory stores all objects and their attributes, including security attributes. All 
servers in the Microsoft Windows 2000 domain are peers to one another and share 
responsibility for security management. Users can log on through any server and 
account information can be updated on any server. Servers dynamically share 
account update information with all other servers in the domain.

Trust relationships between domains

In large networks, or in networks where you want to create separate domains for 
different departments or for security reasons, you can establish multiple domains. 
You can designate trust relationships between domains to provide members of one 
domain with access to the resources of another domain without having to logon to 
separate domains. The type of trust relationship you designate varies according to 
network and security requirements. 

For example, you can create a domain for the sales department and another 
domain for the accounts department. You can provide users of the accounts 
domain with access to resources in the sales domain, without granting access to 
accounts resources to users in the sales domain. In this scenario you can create a 
one-way trust relationship between these domains. Domain controllers for the 
sales domain trust users logged on to the accounts domain, but users logged on to 
the sales domain are not trusted by domain controllers for the accounts domain.

However, if you also want to allow access to the accounts domain to users logged 
on to the sales domain, you can create a two-way trust relationship between the 
domains. Two-way trust is established in different ways on Windows NT and 
Microsoft Windows 2000 platforms:

• On a Windows NT network, you must designate two one-way trust 
relationships between two domains.
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• On a Microsoft Windows 2000 network you can designate a two-way trust 
relationship between two domains.

Symposium TAPI SP domain considerations

On a Windows NT network, the Symposium TAPI SP server is usually designated 
either as a PDC or as a standalone server. If you plan to designate the TAPI server 
as a PDC, consider the processing requirements before configuring the server.

Before establishing TAPI services and installing Symposium TAPI SP, must 
understand the domain and security requirements of the network. Microsoft 
recommends two-way trust relationships for TAPI services. However, some 
customer requirements can dictate one-way trust relationships for security 
purposes. This section provides two sample trust relationship configurations for 
Symposium TAPI SP in a multidomain network. 
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Figure 17 shows a standard multidomain configuration with two-way trust 
relationships between the TAPI resource domain and user domains.

Figure 17   Standard multidomain configuration
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Figure 18 shows a non-standard multidomain configuration with one-way trust 
relationships between the TAPI resource domain and user domains.

Figure 18   Non-standard multidomain configuration
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Configuring domains on the TAPI server

This section describes how to configure domains on both a Windows NT and a 
Microsoft Windows 2000 server. On a Windows NT server, you can configure the 
server to be either:

• a standalone (member) server
• a PDC if no PDC exists

Configuring a Windows NT server as a standalone server 

To configure the TAPI server as a standalone server in a domain perform the 
following tasks:

1 Ask your network administrator to add the standalone server to the domain.

2 Ask your network administrator for a user account on the domain with 
administrator rights. This account enables your telephony service to run 
TCMSETUP on your local machine.

3 Ask your network administrator to verify that all TAPI users are configured as 
domain users.

4 Log on to your local machine as administrator.

Note: Consider the processing implications before you configure the 
TAPI server as a PDC, and verify that CPU utilization on the server, with 
the logger application in use, does not exceed 50% of capacity.

Note: Always log on to your local machine as administrator. Never log 
on directly to the domain server.
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5 Select Start > Programs > Administrative Tools > User click Administrators 
to display the Local Group Properties window. (Figure 19)

Figure 19   Local Group Properties window

6 Highlight your domain user account and click Add to display the Add Users 
and Groups window. (Figure 20)

Figure 20   Add Users and Groups window
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7 Locate and highlight your user account for your telephony service and click 
Add to ensure that your user account now displays on the Local Group 
Properties window. (Figure 21)

Figure 21   User account in Local Group Properties window

Configuring a Windows NT server as a PDC

To configure the TAPI server as a primary domain controller perform the 
following tasks:

1 Add all users to the server.

2 Select Start > Programs > Administrative Tools > User Manager, to display 
the User Manager window.

3 In the User Manager window, add a user to the server with administrators 
privileges to run telephony services on the server. This user account will be 
used only with telephony services startup, TCMSetup and optional 
ACDProxy startup on this server. Nortel Networks recommends that you do 
not use the administrator account for this purpose.
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4 To add a client machine to the domain, select Start > Programs > 
Administrative Tools > Server Manager. Select the Computer tab and then 
click Add to Domain.

5 Enter the name of the client computer exactly as it appears on the client PC.

6 Select the appropriate operating system and click Add.

7 Repeat steps 4 through 6 for each client you want to add to the domain.

Configuring domains on a Microsoft Windows 2000 server

The active desktop environment on a Microsoft Windows 2000 server provides 
dynamic domain management. To configure the server as a member of a domain 
perform the following tasks:

1 Ask your network administrator to add the server to the domain.

2 Ask your network administrator for a user account on the domain with 
adminstrators rights.This account enables your telephony service to run 
TCMSETUP on your local machine.

3 Ask your network administrator verify that all TAPI users are already 
configured as domain users.

4 Log on to your local machine as administrator.

Note: Clients can log on to one domain at a time only. If a client wants to 
log on to the TAPI domain, the user must first log off from any other 
domain. 

Note: Always log on to your local machine as administrator. Never log 
on directly to the domain server.
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5 Select Start > Programs > Administrative Tools > Active Directory > Users 
and Computers and click Administrators to display the Local Group 
Properties window. (Figure 22)

Figure 22   Local Group Properties window

6 Highlight your domain user account and click Add to display the Add Users 
and Groups window. (Figure 23)

Figure 23   Add Users and Groups window
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7 Locate and highlight your user account for your telephony service and click 
Add to ensure that your user account now displays on the Local Group 
Properties window. (Figure 24)

Figure 24   User account in Local Group Properties window

8 To add a client machine to the domain, select Start > Programs > 
Administrative Tools > Server Manager. Select the Computer tab and then 
click Add to Domain.

9 Enter the name of the client computer exactly as it appears on the client.

10 Select the appropriate operating system and click Add.

11 Repeat steps 8 through 10 for each client you want to add to the domain.

Note: Clients can log on to one domain at a time only. If a client wants to 
log on to the TAPI domain, the user must first log off from any other 
domain. 
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Remote procedure calls and trust relationships

When a remote TAPI client communicates with a TAPI server, two remote 
procedure calls (RPCs) are required. This requirement often causes problems 
because network administrators do not usually configure their networks to allow 
reverse RPC requests which are not necessary for most network services. 
Telephony services are an exception because they rely on domain-based 
validation, which requires reverse RPCs. 

In a typical TAPI call, the following communication occurs:

• The client sends an RPC request to the TAPI server over a TCP/IP connection.
• The TAPI server verifies the client by communicating with the primary 

domain controller of the server machine domain.
• If the server machine domain trusts the user domain, the client is validated 

and the TAPI server looks up what lines the clients has permission to use.
• The TAPI Server sends a second (reverse) RPC request to the primary domain 

controller for the client machine domain to verify the client. 
• If the client machine domain trusts the server user domain, the validation 

succeeds.

In this example, the following trust relationships are necessary:

• The server machine domain must trust the server user domain.
• The client machine domain must trust the client user domain to enable client 

users to log in.

Trust relationships are simplified if the server machine domain is the same as the 
server user domain, or if the user machine domain is the same as the user domain. 
These groups can be configured as members of just one domain, or they can be 
configured as four separate domains, depending on network requirements. 

Common causes for failure of the second RPC connection include:

Microsof

Note: The behaviour described in this section does not occur in a 
network where Windows 2000 client machines are validated by a 
Microsoft Windows 2000 server. A second RPC is not required in such a 
network configuration.
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• The client machine domain doesn’t trust the server user domain. This 
common failure occurs when the server is in a resource domain that has a 
one-way trust relationship with the user domain.

• the client machine is not correctly configured to validate using domain 
accounts

• the client machine is not configured to allow the server user to use network 
resources

Where there is a resource domain, the simplest configuration is to place the server 
user account into the client user domain, creating just one user domain which is 
trusted by both machine domains.

To test whether your the server machine and client machine are correctly 
configured for RPCs, perform the following tasks:

1 On the client machine, log in as the client user.

2 In the DOS window, enter the following command:
NET VIEW \\ServerMachine

If the command succeeds, even if there are no entries in the list, the first RPC 
connection can be made.

3 On the server machine, log in as the server user.

4 In the DOS window, enter the following command:
NET VIEW \\ClientMachine

If the command succeeds, even if there are no entries in the list, the second 
RPC connection can be made.

If either of the net view commands fails, you have a security problem that must be 
resolved. During validation TCP/IP must be the only protocol installed on the 
server machine to ensure that the tests do not use other protocols to succeed 
accidentally.

Client user issues

The scenarios described above assume that the logged on user is the client user. 
Problems can occur because the client user is the first application that sends a 
lineInitialize command to the TAPI server. If a TAPI-based application, such as 
remote access services (RAS) or Microsoft Fax, is configured to wait for 
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incoming telephone calls, the application can start before a user logs on to the 
TAPI server. In this situation the client user is the TAPI application, not the logged 
on user, and the server denies any line devices to Symposium TAPI services. It is 
not possible to renegotiate with the server to establish the logged on user as the 
client user. 

The solution is not to install a modem on the client user machine, and not to install 
modem-based applications. If you encounter such problems, check if telephony 
services are running immediately after you log on, before starting any TAPI 
applications. If telephony services are running, identify the application that is 
causing TAPI to start up too early. It may be possible to change configurations to 
stop the application starting automatically. However, Nortel Networks 
recommends that you uninstall the application. 

Configuring Microsoft TAPI for Symposium TAPI SP

The information in this section is designed to supplement the TAPI documentation 
provided by Microsoft. Before you install Microsoft TAPI, consult the Microsoft 
TAPI readme.txt file. Follow the installation procedures provided in that 
document.

This section provides guidelines for configuring the following elements of the 
TAPI environment: 

• Assigning lines to users
• Configuring client PCs

Before you begin, verify the following:

• The required operating system and service pack is installed on the server and 
the server is functioning correctly. Refer to the Engineering Guidelines for 
Symposium TAPI Service Provider for Meridian 1, part number 213345-A for 
more information.

• The ACDProxy service login and password are set up and are the same as the 
login and password used by the telephony service.

• The user login and password are set on the server.
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The following section describes how to configure the TAPI environment on a 
Windows NT 4.0 server. Information on configuring the TAPI environment on a 
Microsoft Windows 2000 server is provided on page 80.

Avoiding basic configuration problems

You can avoid basic configuration problems if you comply with the following 
guidelines:

1 Run TCMSetup on the server and client machines.

2 Use TCMApp to configure line permissions.

3 Verify that TAPIAdmin is a domain account.

4 Verify that TAPIClient is a domain account.

5 Configure TCP/IP on server and client machines.

6 Install service pack 6a or higher on a Windows NT 4.0 server and any 
Windows NT 4.0 clients.

7 Install service pack 2 or higher on a Windows 2000 server.

8 Configure file sharing and user level access on Windows 9x clients.

9 Set log on validation to log onto Windows domain for Windows 9x clients.
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Configuring a Windows NT server for Symposium TAPI SP

When you install Symposium TAPI SP, you must prepare the server for TAPI 
operations.

Enabling telephony services

To enable telephony services on a Windows NT server, select Start > Run and 
enter the following command, substituting appropriate values where necessary:

tcmsetup.exe /s domain \userid password (

where: 
s is the server name
domain is the domain of the TAPI server
userid is the user ID for a user with administration privileges for telephony 
services
password is the password associated with this user ID.

When the telephony services are set up a confirmation window appears. 

Assigning lines to clients

To assign lines to TAPI clients, perform the following tasks:

1 Select Start > Run and select the TCMApp.exe, located in the 
c:\Winnt\system32 directory to display the TAPI administration application 
window. (Figure 25) 

Figure 25   Selecting Add a User 
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2 Select User > Add a User to the Telephony Server to add a client to the server.

3 Select the client in the main panel of the TAPI administration application 
window and select User > Change Selected User’s Line Access (Figure 26). 
Highlight the line you want to associate with this user and click OK to save 
the configuration.

Figure 26   Selecting Changing Selected User’s Line Access

4 The line you select appears underneath the entry for the client in the main 
pane of the TAPI administration application window.

5 Repeat these procedures to add each client and to assign lines to all of them.

6 Exit the application, clicking Yes when prompted to do so to save the 
information. 

Configuring a Microsoft Windows 2000 server for 
Symposium TAPI

After you install Symposium TAPI SP, you must prepare the server for TAPI 
operations. 

Note: The first time you run TCMApp.exe, you must select User > Add a 
User to the Telephony Server before the following configuration windows 
can appear.
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Enabling telephony services

To enable telephony services on a Windows 2000 server perform the following 
tasks:

1 Select Start > Run and enter the following command:
tapimgmt.msc(

2 Before you can enable the telephony server you must start telephony services 
by selecting Start > Settings > Control Panel > Administrative Tools > 
Services to display the services administration window. Select Telephony and 
right-click your mouse to display the properties for telephony services, which 
provides these options: 

• start
• stop
• pause
• resume 

3 Select Start.

4 Select Start > Programs > Administrative Tools > Computer Management > 
Services and Applications > Telephony to display the Telephony Services 
administration window. 
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5 If the server you want to manage does not appear on the server list, select the 
Action menu > Add Computer to display the Select Computer 
window.(Figure 27)

Figure 27   Select Computer window

6 In the Look in field, highlight the domain for the server. In the Name field 
enter the name of the server. The server now appears on the server list in the 
telephony administration window.
213346-A



Chapter 3 Preparing the TAPI environment 83

 

7 Select the server you want to manage in the server list and select Action menu 
> Properties to display the Telephony Server Properties window. (Figure 28)

Figure 28   Telephony Server Properties window

8 In the Setup tab select Enable telephony server. If the Enable telephony server 
option is unavailable, checked that you clicked Start in Step 2 above.

9 In Account Information type the user name and password for the account that 
will run the telephony service on the server. 

The

Note: The account to manage the telephony server must be a member of 
the administrators group on the server. The account must be also in the 
same domain as the TAPI server or be in a domain that has a two-way 
trust relationship with that domain.
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10 If you want to add a telephony administrator who is not an administrator on 
the server, click Add to display the Select Users window. (Figure 29)

Figure 29   Select Users window

11 In the Look in field, select the domain where the user is located. Select the 
user name from the list of names that is displayed, and click Add. Click OK 
and this information will appear in the Telephony Server Properties window.

12 In the telephony services properties window, click OK to save changes.

Assigning lines to clients

To assign lines to TAPI clients, perform the following tasks:

1 Select Start > Programs > Administrative Tools > Telephony to display the 
telephony service administration window. (Figure 30)
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Figure 30   Telephony Services administration window

2 Select the telephony services provider from the list of service providers and 
select Action menu > Edit Users to display the Edit Users window.(Figure 31)

Figure 31   Edit Users window

3 Select Add to display the Select Users window. (Figure 29).

4 In the Look in field, select the domain where the user is located. Select the 
user name from the list of names that is displayed, and click Add. Click OK to 
save these changes. The users name appears as an assigned user in the Edit 
Users window.

5 Repeat these procedures for each user that you want to add as a TAPI client.
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6 If you want to remove a user, select the user’s name from the list of assigned 
users in the edit user window and click Remove, and then click OK to save the 
change.

Configuring TAPI clients

All client PCs must conform to the guidelines provided in the Engineering Guide 
to Symposium TAPI Service Provider for Meridian 1, part number 213345-A. 
Because client PCs can be logged in to only one domain at a time, remove all PCs 
you are configuring for TAPI from any prior domains before you configure them 
for TAPI. If necessary, install Microsoft TAPI, release 2.x or release 3, on the 
client before specifying the telephony server(s). To do this, select Start > Run and 
enter tcmsetup /c server1 server2, where server1 and server2 represent the server 
names of the TAPI servers.
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Chapter 4
Configuration guidelines

To configure Symposium TAPI Service Provider for Meridian 1, release 2.3.1, use 
the configuration application provided with the software. The configuration 
application populates and maintains the Symposium TAPI SP database tables with 
information about each controllable telephone. In the configuration windows you 
can add, modify, and delete information in the database tables. If you have 
multiple customer numbers, you can maintain this information in separate 
databases. 

Use the configuration application to enter information, automatically or manually, 
into the database tables. In an automatic configuration, information about 
controllable telephones is downloaded from the Meridian 1 switch. The 
configuration application then translates this information and enters it into the 
Symposium TAPI SP database tables. In a manual configuration, instead of 
downloading information from the Meridian 1 switch, you enter the information 
manually in the various windows in the configuration application. Manual 
configuration is time-consuming if you need to control a large number of agents.

After information is entered into the database, you can add, modify, or delete this 
information in the configuration application. In a direct connect environment, 
Symposium TAPI SP dynamically updates such changes to the database tables. In 
a call center environment, changes to the database tables are automatically 
updated in the DNRelease indication message sent from the SCCS to Symposium 
TAPI SP. This process updates the database by deleting DNs and TNs. Changes 
made in the configuration application do not affect the information on the 
Meridian 1 switch. This chapter provides guidelines for:

• downloading configuration information from the Meridian 1 switch
• using the Symposium TAPI SP configuration application 
• configuring an additional customer
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Downloading information from the Meridian 1 switch

Before you download information from the Meridian 1 switch, create a switch 
configuration information text file on the TAPI server:

1 In Notepad or a similar text editor application, create a text file.

2 Save this text file as download.txt in the c:\m1server directory on the TAPI 
server.

3 Connect to the Meridian 1 switch from the TAPI server in one of the 
following ways:

— On a Windows NT server, select Start > Programs > Accessories > 
Hyperterminal.> HyperTerminal application.

— On a Microsoft Windows 2000 server, select Start > Programs > 
Accessories > Communications > HyperTerminal application.

4 When the port settings window opens, log on to the switch.

5 Select transfers.

6 In the HyperTerminal application on a Windows NT server, select the Receive 
option; on a Microsoft Windows 2000 server, select the Capture Text option.

7 Select the download.txt file that you created earlier.

8 To capture information about all used terminal number blocks (TNB), enter 
the following commands in overlay 20:
> LD 20
REQ: PRT
TYPE: TNB
CUST 0 (or customer number)
~
DES <cr>

Note: When you log on to the Meridian 1 switch, if transfers does not 
appear, press the Return key until it is displayed.

Note: To download information from the Meridian 1 overlay applications 
can take a long time.
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9 To capture information about route data blocks (RDB), enter the following 
commands in overlay 21:
> LD 21
REQ: PRT
TYPE: RDB
CUST: 0 (or customer number)
~
ACOD <cr>

10 To capture information about control directory number (CDN) blocks, enter 
the following commands in overlay 23:
> LD 23
REQ: PRT
TYPE: CDN
CUST: 0 (or customer number)
~
CDN <cr>

11 Ater you dowload the iinformation from the overlays, stop the hyperterminal 
application.

12 Close the hyperterminal application to save the information.

Converting the text file

To convert the text file containing switch information, perform the following tasks 
in the Symposium TAPI SP configuration application:

Note: Download only the CDNs that you require for TAPI operation. If 
you download other CDNs, you must delete them after the download is 
complete. 
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1 Select Start > Programs > Nortel > Nortel Symposium TAPI Service Provider 
for M1 to start the configuration application (Figure 32).

Figure 32   Configuration application window
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2 Click Convert Text file to display the open window. (Figure 33)

Figure 33   Opening the download.txt file

3 Select c:\m1server\download.txt. Click Open to display the Text File 
Translator Status window.(Figure 34)

Figure 34   Text File Translator Status window

4 Click Start. 
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The conversion process adds all information downloaded from the Meridian 1 
switch to the Symposium TAPI SP database. Some of this information can be 
unnecessary or inappropriate. For example, the Meridian 1 switch assumes that 
IVR ports are analog. These ports must be set on the TN Table window of the 
configuration application. You must delete CDNs that are downloaded that 
Symposium TAPI SP does not need to monitor.

Configuring the Symposium TAPI SP database 

This section describes the Symposium TAPI SP database tables and how to 
manage them in the Symposium TAPI SP configuration application. Each 
database table has an associated window in the graphical user interface (GUI) of 
the configuration application. The database tables are:

• Provider
• Meridian 1 Host
• Network TAPI/IVR Server
• Log Styles
• Compliance

Note: Nortel Networks recommends that only experienced database 
administrators configure the Symposium TAPI SP database.
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Configuring the provider table 

In the provider table configuration window you can add, modify, or delete 
information about the application that is registered currently with Meridian Link 
Services. (Figure 35)

Figure 35   Provider Table window
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You can perform the following configurations in the Provider Table window:

• Application name. A string of up to 19 ASCII characters that identifies the 
provider application. If you enter more than 19 characters Meridian Link 
Services does not operate.

• Timeout values. You can configure timeout values for the following events. 
The default values are sufficient for 50 users but you must increase these 
values if you are adding more than 50 users
— Initialization — the length of time that Symposium TAPI SP waits to 

establish communication with the switch before generating an error. The 
default and minimum value is 32 seconds.

— Shutdown — the length of time that Symposium TAPI SP waits for 
shutdown to be completed before generating an error. The default value 
and minimum value is 32 seconds.

— Command — the length of time that Symposium TAPI SP waits for a 
command response before generating an error. The default and minimum 
value is five seconds.

• Call data size. Enter the number of bytes that can be stored as call data. The 
default size is 512 bytes but Nortel Networks recommends that you change 
this size to reflect actual requirements to minimize the amount of network 
load allocated to call data traffic.

• Call data life span. Enter the length of time that call data will be stored.
• Disable copy of call data to consultative call. A new feature available with 

Symposium TAPI Service Provider for Meridian 1, release 2.3.1, which 
allows you to disable copying call data when calls are transferred or 
conferenced.

• Log style. Select the number of log style to use for troubleshooting purposes. 
The default style is 1 and you can create new log styles in the Log Styles 
window.
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Configuring the Meridian 1 Host table

In the Meridian 1 Host window of the configuration application you can add, 
modify, or delete host/machine/association information contained in the Meridian 
1 Host database. (Figure 36)

Figure 36   Meridian 1 Host window
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In the Meridian 1 Host window you can perform the following configurations:

• Host name. Nortel Networks recommends that you do not change the default 
setting. The host name is case-sensitive, containing a maximum of 20 
characters that represent the host name.

• Host address. Enter the IP address of the host for Meridian Link Services. In a 
call center, the host address is the IP address of the SCCS. In a direct connect 
environment, the host address is the IP address of the E-LAN port on the 
Meridian 1 switch.

• Meridian Link release. Select the correct release number of Meridian Link 
Services.

• Machine name. Enter a string of a maximum of 20 ASCII characters that 
identifies the Meridian 1 switch associated with the registered application. 

• Meridian 1 release — select the correct release number of the Meridian 1 
application.

• Host port. This port number must match the one configured in the Meridian 
Link Services. In an SCCS configuration accept the default. For a direct 
connect configuration, change the entry to 8888.

• Phantom DN. A reserve DN configured on the switch for the following call 
features:
— Hold
— Transfer
— Redirect
— Conference

• Customer number. If multiple customers are configured you can specify a 
particular one in this field.

• Registration password . You can use this optional field if you require an 
association with a specific registration. You can enter a character string of 
four to sixteen characters.
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• Polling interval. The default value is 0, and valid values are 0 through 100. 
The value determines the frequency with which Meridian Link Services polls 
the link between the SCCS and Symposium TAPI SP. In a call center 
environment, you must set a link value greater than 0 to ensure link detection 
between Meridian Link Services and Symposium TAPI SP. If you set a link 
value of 1, the link is polled every 10 seconds.

• Monitor all DNs/no DNs. Select the appropriate checkbox. The default is to 
monitor all DNs.

• Services. Select the required services.

You can access four Meridian 1 Host table submenus by clicking on the buttons at 
the bottom of this window.

Configuring the trunk table

Symposium TAPI SP uses information in the trunk table to monitor outbound 
trunk routing. Before you can monitor a trunk, verify that: 

• the trunk is configured as an associated set (AST) on the switch
• the IAPG is configured to select the appropriate events (1 = all events) 
• the trunk is configured for monitoring on the TAPI server

To configure the trunk table click on Trunk Table in the Meridian 1 Host 
configuration window. In the Trunk Table window you can perform the following 
configurations:

• Add a route number record. Enter the number of a route you want to monitor.

Caution: In a call center environment, you must change the default 
polling interval value of 0 to at least 1 to ensure that link loss is detected 
between Meridian Link Services and Symposium TAPI SP.

Note: The status of a monitored trunk is detected only if answer and 
disconnect supervision are enabled for the trunk. On a digital trunk 
interface, answer supervision and disconnect supervision is enabled by 
default. For a universal trunk card, in overlay 14, set the SUPN prompt to 
yes to enable answer supervision and disconnect supervision.
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• Delete a route number record. Delete the number of a route that you no longer 
want to monitor.

• Add a range of route numbers. Add a range of route numbers to monitor.
• Delete all route numbers. Delete all route numbers to prevent the monitoring 

of outbound trunks.

Configuring the treatments table 

The treatments database table is used by the routing application. You can add new 
treatments in the Treatments Table window in the configuration application. If 
you make changes in the Treatments Table window they apply only to the 
information contained in the Symposium TAPI SP database and do not affect the 
configuration of the Meridian 1 switch.

To access the Treatments Table window click on Treatments Table in the Meridian 
1 Host configuration window. (Figure 37)

Figure 37   Treatments Table window

In the Treatments Table window you can perform the following configurations:

• Treatment name. Type a maximum of 32 characters that identifies this 
treatment (user-defined).

• Route number. Type a number between 1 through 511 that identifies the route 
number for this treatment.

• Log style. Select the log style for this treatment. To create a new log style for 
this treatment click Log Style Table to display the log style table window.
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• Treatment type. Select Music to play music or select RAN to play a recorded 
announcement.

• Add. Create a new treatment.
• Delete/delete all. Delete a treatment/delete all treatments.

To add a new treatment:

1 Click Add Treatment to display the add new treatment window.

2 Type a new treatment number and click OK.

3 In the main Treatments Table window select a route number, log style, and 
treatment type.

4 Click OK to save the new treatment to the treatments table in Symposium 
TAPI SP.

To modify a treatment:

1 Scroll through the treatment numbers in the treatment number field and 
highlight the treatment number you want to modify.

2 When this treatment number appears in the treatment number field, make 
required changes in any or all of the following fields:

— route number
— log style
— treatment type

3 Click OK to save the modified information to the treatments table in 
Symposium TAPI SP.

To delete a treatment:

1 Scroll through the treatment numbers in the treatment number field and 
highlight the treatment number that you want to delete.

2 When this treatment number appears in the treatment number field, click 
delete.

3 Click OK to save this information to the treatments table in Symposium TAPI 
SP.
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4 To delete all treatments, click Delete All. Click OK to save this information to 
the treatments table in Symposium TAPI SP.

Configuring the TN table 

The TN table contains the terminal number (TN) and directory number (DN) 
configurations on the Meridian 1 switch. Each line configured on the switch has a 
terminal number (TN). You can associate a maximum of two directory numbers 
(DNs) with each TN. 

Adding a new TN

To add a new TN to the TN table:

1 In the Meridian 1 Host configuration window click TN Table to display the 
Line Devices window. (Figure 38)

Figure 38   Line Devices window
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2 Click Add Line to display the Add a Terminal Number Record window. 
(Figure 39)

Figure 39    Add a Terminal Number Record window

3 Type the loop, shelf, card, and unit numbers that identify the physical location 
on the Meridian 1 switch of the TN you are adding. 

4 Click OK to save the new TN to the TN table. 

5 Perform the procedures described below to modify the information for this 
TN.

Modifying a TN

To modify the information associated with a TN:

1 Click TN Table in the Meridian 1 Host configuration window to display the 
Line Devices window.(Figure 38) 

2 Select the line you want to configure from the panel on the left side of the 
window. If you do not know the line number for the TN, enter the TN number 
in the field at the top left of the Line Devices window to search for the 
associated line number.
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3 After you select the appropriate line, click Properties to display the Line 
Properties window. (Figure 40)

Figure 40   Line PAdd a Terminal Number Record windowroperties window

4 Select the line features, phone type, and log style that you want to configure 
for this TN.

5 Click OK to save this information to the TN table.

Deleting a TN/all TNs

To delete a line from the TN table:

1 In the Line Devices window, select the line you want to delete in the panel on 
the left side of the window.

2 Click the Del button to delete this line from the TN table.
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3 In the warning message window that is displayed (Figure 41), clcik OK to 
delete the line from the TN table.

Figure 41   Warning message

4 To delete all TNs from the TN table, in the Line Devices window, click Delete 
All. Click OK in the warning message window that is displayed.

Adding a DN

You can associate a maximum of two DNs with each line in the TN table. When 
you add, modify, or delete information in the DN table, the TN table reflects the 
changes. To add a new DN:

1 In the Line Devices window, in the panel on the left side of the window, select 
the line number to which you want to add a DN.

2 Click Add DN on the right side of the window to display the add a directory 
number record window. 

3 Type the directory number and select the DN type. Click OK to save this 
information to the DN table and the TN table.

4 Modify the information associated with this DN.

Modifying a DN

To modify a DN:

1 In the Line Devices window, locate the line number that you want to 
configure in the left panel of the window.

2 Expand the information under this line number to display its associated DN or 
DNs.
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3 Select the DN that you want to modify. Click Properties to display the DN 
Properties window. (Figure 42)

Figure 42   DN Properties window

4 Type information in fields as required. Click OK to save these changes to the 
DN table and the TN table.

Deleting a DN

To delete a DN from the DN table and the TN table:

1 In the Line Devices window, select the DN you want to delete.

2 Click the Del button.

3 Click OK in the warning window that is displayed to save the information to 
the DN table and the TN table.

Configuring the CDN table

Information in the control directory number (CDN) table is used for host 
enhanced routing.
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To access the CDN window shown in Figure 43, click CDN Table in the Meridian 
1 Host configuration window:

Figure 43   CDN window

To add a new CDN:

1 In the CDN window, click Add to display the Add a Control Directory 
Number window. (Figure 44)

Figure 44   Add a Control Directory Number window

2 Type the CDN you wish to add. Click OK to save the information to the CDN 
table.

To modify a CDN:

1 In the CDN window scroll the entries in the DN field. Select the DN you wish 
to modify.

2 Select the desired log style or click Log Style Table if you want to create a 
new log style for this DN.
Network Managers Guide for Symposium TAPI Service Provider for Meridian 1, release 2.3.1



106 Chapter 4 Configuration guidelines

 

3 Click OK to save this information to the CDN table.

To delete a CDN:

1 In the CDN window scroll the entries in the DN field. Select the DN you wish 
to delete.

2 Click Delete.

3 Click OK to save these changes to the CDN table.

Configuring the network TAPI/IVR table

The IVR driver on Symposium TAPI SP uses information in the IVR host table 
database for the following:

• to open a listening IVR port that the IVR application uses to register with the 
IVR driver on the TAPI server 

• to keep this link open between Symposium TAPI SP and the IVR system, so 
that the IVR system can send call data to the TAPI server 

In a networked environment, the IVR driver uses information stored in the remote 
host address table to request call data for inbound calls overflowed from a remote 
Meridian 1 swtich. 

Refer to Chapter 6, “Networked TAPI/IVR,” on page 129 for information about 
networking and IVR features for Symposium TAPI SP. 
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To configure IVR for Symposium TAPI SP, click the Network TAPI/IVR Server 
tab in the main window of the configuration application. (Figure 45)

Figure 45   Network TAPI/IVR server window
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In the network TAPI/IVR configuration window you can configure the following 
elements:

• IP address of the IVR server.
• Home location code (HLOC) of the Meridian 1 switch for the IVR system, 

which is the same as the HLOC printed on the switch, in overlay 21.
• Port address. The default port value for the IVR port is 5000 but you can 

change this if you discover port conflicts.
• Protocol. TCP/IP is the required protocol.
• Remote TAPI server host addresses. To attach call data to calls during an 

ACD transfer or a NACD overflow, you must specify a remote host address 
for each TAPI server in the network.

Adding an IVR remote host address

To add an IVR remote host address:

1 In the Network TAPI/IVR Server window, click Add to display the Add 
Remote Host Address window. (Figure 46)

Figure 46   Add Remote Host Address window

2 Type the following in the appropriate fields:
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• the IP address of the remote TAPI server
• the HLOC for the Meridian 1 switch associated with the remote TAPI 

server
• the port address for the remote IVR driver
• the protocol for the remote IVR driver 

3 Click OK to return to the Network TAPI/IVR Server window.

4 Click OK in this window to add the remote host address to the database.

Modifying an IVR remote host address

To modify an IVR remote host address:

1 In the Network TAPI/IVR Server window, select the entry you want to modify 
in the list of remote host addresses.

2 Click Edit to display the Edit Remote Host Address window. (Figure 47)

Figure 47   Edit Remote Host Address window

3 Modify the values that you want to change. Click OK to return to the Network 
TAPI/IVR Server window.

4 Click OK in this window to save the modified information to the database.
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Deleting an IVR remote host address

To delete an IVR remote host address:

1 In the Network TAPI/IVR Server window, click the entry you want to delete 
in the list of remote host addresses.

2 Click Del to delete the entry from the remote host address list.

3 Click OK to delete the remote host address from the database.

Deleting all IVR remote host addresses

To delete all IVR remote host addresses:

1 In the Network TAPI/IVR Server window, click Delete All. 

2 Click OK to save the changes to the database.
213346-A



Chapter 4 Configuration guidelines 111

 

Configuring SAP compliance

Symposium TAPI Service Provider, release 2.3.1, supports mySAP and 
SAPphone. To enable SAP compliance on the TAPI server, click the Compliance 
tab on the main window of the configuration application. (Figure 48)

Figure 48   Compliance window
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Click in the check box to enable SAP compliance. (Figure 49)

Figure 49   Enabling SAP compliance

SAP compliance is currently the only feature that you can enable in the 
compliance window.
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Configuring the log styles table 

The log styles table provides information for the logger troubleshooting 
application. Each item in the Symposium TAPI SP database is assigned a log 
style. You cannot modify or remove two default log styles. These default settings 
are 0, which logs no items, and 1, which logs all items. For troubleshooting 
purposes, you may need to create additional log styles to trace specific data items. 

Log styles are numbered consecutively. Numbers 0 and 1 are default styles. The 
first log style you create is number “2”. Continue to number the log styles in 
sequence. If you delete a log style, all subsequent log style numbers are reduced 
by one, and the configuration application dynamically updates all Symposium 
TAPI SP database tables to reflect the change in log style numbers. 
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Adding a log style

To add a new log style to the log style table:

1 Click the Log Styles tab in the main window of the configuration application 
to display the log styles window. (Figure 50)

Figure 50   Log styles window
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2 Click Add. The number in the Log Style Number field increases to the next 
consecutive number.

3 Click OK to save the new log style number to the log style table and return to 
the main window of the configuration application.

4 Click the Log Styles tab to display the log styles window again.

5 Click the check boxes next to the data items you want the logger application 
to log and display. 

6 Click OK to save the changes and return to the main window of the 
configuration application. 

The new log style is now available in all configuration windows. 

Editing a log style

To edit a log style:

1 In the log style window, select the log style you want to edit in the Log Style 
Number field. 

2 Click the check boxes next to the data items you want to include, or deselect 
check boxes next to the data items you want to remove. 

3 Click OK to save the changes and return to the main window of the 
configuration application. 

Deleting a log style 

 To delete a log style:

Note: You can view the log styles window from several configuration 
windows. However, if you wish to add or delete log styles you must 
access the log styles window by clicking the Log Styles tab in the main 
window of the configuration application.

Note: You cannot edit or delete log styles 0 and 1, which are the default 
log styles.
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1 In the log style window, select the log style you want to delete in the Log 
Style Number field.

2 Click Delete. 

3 Click OK to save the changes and return to the main window of the 
configuration application.

The configuration of Symposium TAPI SP is now complete. Repeat the 
procedures if multiple customers are configured on the Meridian 1 switch. If only 
one customer is configured on the switch, exit the configuration application by 
clicking Quit.

Configuring an additional database

If you have multiple customer numbers (0 and 1), you can create separate 
Symposium TAPI SP databases for each customer. When you download 
information from the Meridian 1 switch for the first database, for customer 0, this 
information is saved by default in the c:\m1server directory as m1spdb.mbd. To 
create a new customer database, you must define a different name for the file, or 
store it in a different directory. To perform an automatic configuration, ensure that 
the correct customer number is specified in Meridian 1 overlays. For information, 
refer to “Downloading information from the Meridian 1 switch” on page 88.

If you create an additional database, ensure the correct database file is loaded 
before accessing the Symposium TAPI SP configuration application to perform 
additional configurations. You cannot switch databases when the configuration 
application is running. To switch to another customer database, you must close the 
configuration application, reload the correct database file, and restart the 
configuration application.
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Chapter 5
Upgrading Symposium TAPI SP

This chapter describes how to perform the following upgrades to Symposium 
TAPI SP:

• upgrade software from an earlier release to Symposium TAPI Service 
Provider for Meridian 1, release 2.3.1

• upgrade your TAPI system to add clients or features or to change the TAPI 
environment

Upgrading Symposium TAPI SP software

When you upgrade from an earlier release of Symposium TAPI SP software you 
can install a PEP or perform a full reinstall. You can download the PEP from the 
Nortel Networks Website. A copy is also supplied on the Symposium TAPI SP, 
release 2.3.1 software CD. If you avail of the free upgrade option available to 
Symposium TAPI SP, release 2.3 customers, you can access the PEP only from the 
Nortel Networks Website.

Installing a product enhancement package

Before you install the PEP file shut down Symposium TAPI SP and switch off 
telephony services and ACD proxy services:

Note: Nortel Networks recommends that you make a backup copy of 
your m1spdb.mdb file and store it in a safe location any time you perform 
an upgrade to Symposium TAPI SP. Repeat the backup procedure after 
you complete the upgrade. 
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• On a Windows NT 4.0 server, select Start > Settings > Control Panels > 
Services. In the Services Administration window, select Telephony, right click 
the mouse, and click Stop. This procedure also stops ACD proxy services. 
Verify that both services are stopped before you proceed.

• On a Microsoft Windows 2000 server, select Start > Settings > Control Panels 
> Administrative Tools > Services. In the Services Administration window, 
select Telephony, right click the mouse, and click Stop. This procedure also 
stops ACD proxy services. Verify that both services are stopped before you 
proceed.

To install the PEP file, perform the following tasks:

1 Start the ML2.3.1pep.exe application.

2 Specify the location where the extracted files will be placed. In the location 
field enter the pathname, such as C:\m1server, where Symposium TAPI SP is 
installed, or click Browse, and navigate to the folder.

3 When you are asked if the file should be overwritten. click Yes To All. 

4 When the installation is complete, restart the server.

To verify that the installation is successful, start the configuration application for 
Symposium TAPI SP, and click the About tab to view information about the 
software. Alternatively, start the logger application and then start Symposium 
TAPI SP. The current release of the software is listed in the header information in 
the logger window.

Performing a full reinstall

To perform a full reinstall, you must uninstall the earlier release of the software 
from the server before you install the new release. 

Note: The default location for Symposium TAPI SP, release 2.2 and 2.3 
is C:\m1server. The default location for Symposium TAPI SP, release 2.1 
is C:\\WINNT\system32 on a Windows NT server. 
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Removing an earlier release from a Windows NT 4.0 server

To remove Symposium TAPI SP from a Windows NT server, perform the 
following tasks

1 Log on to the server.

2 Select Start > Settings > Control Panel > Services to display the Services 
Administration window.

3 In the Services Administration window select telephony services, right click 
the mouse and select stop. This procedure also stops ACDProxy services

4 Select Start > Programs > Nortel > Nortel Networks Symposium TAPI 
Service Provider for M1 > FlexLM License Manager. Select File > Exit to 
stop the license manager.

5 Verify that all TAPI applications on the server, including TCMApp, are 
stopped. For information about services that may be dependent on Microsoft 
TAPI refer to the Microsoft Website at http://www.microsoft.com.

6 Make a copy of the m1spdb.mdb file, which is usually located in the 
C:/M1server directory, and store it in a safe place. This procedure ensures that 
you have a backup copy of the Symposium TAPI SP database in the event of a 
system crash or other failure during the upgrade process.

7 Select Start > Settings > Control Panel > Add/Remove Programs > 
Symposium TAPI Service Provider > Remove.

8 Restart the server to save these changes.

Removing an earlier release from a 
Microsoft Windows 2000 server

To remove Symposium TAPI SP from a Microsoft Windows 2000 server:

1 Log on to the server.

2 Select Start > Settings > Control Panel > Administrative Tools > Services to 
display the Services Administration window.

3 In the Services Administration window select telephony services, right click 
the mouse and select stop. This procedure also stops ACDProxy services
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4 Select Start > Programs > Nortel > Nortel Networks Symposium TAPI 
Service Provider for M1 > FlexLM License Manager. Select File > Exit to 
stop the license manager.

5 Verify that all TAPI applications on the server, including TCMApp, are 
stopped. For information about services that may be dependent on Microsoft 
TAPI refer to the Microsoft Website at http://www.microsoft.com.

6 Make a copy of the m1spdb.mdb file which is usually located in the 
C:/M1server directory and store it in a safe place. This procedure ensures that 
you have a backup copy of the Symposium TAPI SP database in the event of a 
system crash or other unforeseen failure during the upgrade process.

7 Select Start > Settings > Control Panel > Add/Remove Programs > 
Symposium TAPI Service Provider > Remove.

8 Restart the server to save these changes.

Installing the latest software release

Before you install the latest release of Symposium TAPI SP software from your 
CD, verify that the earlier release is removed and that telephony services and 
ACD proxy services are stopped. Refer to Chapter 2, “Installation guidelines,” on 
page 39 for instructions about installing the software. 

Configuring the latest software release

After you complete the quick upgrade or full reinstall of Symposium TAPI 
Service Provider for Meridian 1, release 2.3.1, verify that the configuration 
information contained in the m1spdb.mdb file is entered in the database tables. 
Select Start > Programs > Nortel > Nortel Symposium TAPI Service Provider for 
M1 > Configuration application. 

The latest release of Symposium TAPI SP software adds a Compliance tab which 
provides access to the compliance administration window. This window allows 
you to configure Symposium TAPI SP to support SAPphone. 
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Upgrading your license file

When you perform a full reinstall of Symposium TAPI SP, the FlexLM License 
Manager is also reinstalled, and is automatically configured with information 
from the license.dat file that is supplied on the software CD. It is necessary to 
enter the TAPI server host name in the new license file. For information, refer to 
“Configuring the FlexLM License Manager” on page 60. 

Recovering database table information

If the Symposium TAPI SP database tables are not automatically configured 
during the upgrade procedure, perform a manual update from the backup file you 
made of the m1spdb.mdb file. To manually update the database tables:

1 In the configuration application, click the Providers tab and click Convert 
Text file to display the Open window.

2 Navigate to the location of the backup you made of the m1spdb.mdb file. 
Click Open to import the configuration file into the current release of the 
software.

Verifying the software upgrade

When required upgrade procedures are complete, on the TAPI server, restart 
telephony services and ACD proxy services if required. Start the TAPI browser 
application. Initialize and open all lines.

Retaining line associations

To ensure that line associations are retained when you upgrade to Symposium 
TAPI SP, release 2.3.1, perform the following tasks:

Caution: These procedures require you to change the registry files on 
the TAPI server. Make a backup file of your registry values and store in a 
safe location before you make any changes.
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1 In Notepad or a similar text application, open the tsec.ini file located in the 
Winnt directory on the TAPI server. Following is an example of a tsec.ini file:
[WISCONSIN\Guest]
lines=9,589828
[WISCONSIN\Lab19]
lines=9,589829

2 Note the provider ID in the tsec.ini file, which is the number following 
“lines=”, before the “,” (comma). In this example, the provider ID is 9.

3 Select Start > Run. Type regedit and click OK to begin editing the registry.

4 Select HKEY_LOCAL_MACHINE > Software > Microsoft > Windows > 
CurrentVersion > Telephony.

5 Rename the ProviderX folder, where X is the current numeric value, to 
ProviderY, where Y is the numeric value you recorded for the provider ID 
(Provider9 in the example above).

6 Select the ProviderY folder to display its registry entry, which will be similar 
to the following:
Name Data
(Default) (value not set)
NextProviderID 0x0000000b (11)
NumProviders 0x00000003 (3)
ProviderFilename0 "kmddsp.tsp"
ProviderFilename1 "unimdm.tsp"
ProviderFilename2 "MLINK.XXX"
ProviderID0 0x0000001 (1)
ProviderID1 0x0000002 (2)
ProviderID2 0x000000a (10)

7 Locate the provider filename that precedes the “MLINKSP.XXX” field — 
ProviderFilename2 in the example provided.

8 Locate the provider ID that matches the provider filename, which is 
ProviderID2 on the last line of the example registry file.

9 Double-click this entry, ProviderID2 in the example, and change the numeric 
value shown in parenthesis, (10) in the example, to the provider ID value you 
noted in the tsec.ini file in step 2 above.

10 Select Registry and Exit.

11 Stop ACDProxy service and restart it.

12 Start TCMApp and verify that TAPI server users are assigned specific lines.
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Upgrading Symposium TAPI SP features

When you purchase Symposium TAPI SP, you purchase a license for a specific 
number of clients and a specific range of services. To increase the number of 
clients or change the range of services you must purchase a new license. 

Importing the new license file

Before you can upgrade TAPI services you must purchase a new license, and load 
this new license file onto the server. To load your new license into the FlexLM 
License Manager, perform the following tasks:

1 On the TAPI server, locate the license file that you wish to replace. This file is 
usually located in C:/M1server/license.dat. 

2 Right-click the mouse and select Rename to rename the file, for example as 
oldlicense.dat.

3 Copy your new license.dat file into the c:/m1server directory.

4 Select Start > Programs > Nortel > Nortel Symposium TAPI Service Provider 
for M1 > FlexLM License Manager. Click the Licenses tab and click Show 
License file.

5 The license file opens in Notepad or similar text editor application. Enter the 
TAPI server name in the first line of the license file and select File > Save to 
save this change. For information refer to “Configuring the FlexLM License 
Manager” on page 60.

Increasing the number of clients

After you install the new license file, configure new clients on Symposium TAPI 
SP. If you wish to configure a small number of additional clients you can 
manually configure them in the Symposium TAPI SP configuration application. 
Refer to Chapter 4, “Configuration guidelines,” on page 87 for information about 
configuring clients.

If you want to configure a many additional clients it is more efficient to download 
the configuration information from the Meridian 1 switch. To download 
information for new clients perform the following tasks:
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1 In Notepad or a similar text editor application, create a text file.

2 Save this text file as download.txt in the c:\m1server directory on the TAPI 
server.

3 Connect to the Meridian 1 switch from the TAPI server through one of the 
following:

— On a Windows NT server, select Start > Programs > Accessories > 
Communications > Hypterterminal > HypterTerminal application.

— On a Microsoft Windows 2000 server, select Start > Programs > 
Accessories > Communications > Hyperterminal application.

4 When the port settings window opens, log on to the switch.

5 Select Transfers.

6 In the HyperTerminal application on a Windows NT server select Receive 
Text File;on a Microsoft Windows 2000 server select Capture Text.

7 Select the download.txt file that you created previously.

8 To capture information about additional terminal number blocks (TNB), enter 
the following commands in overlay 20:
> LD 20
REQ: PRT
TYPE: TNB (specify range of new TNBs you want to add to TAPI)
CUST 0 (or customer number)
~
DES <cr>

Note: If the Transfers menu does not appear when you log on to the 
Meridian 1 switch, press the Return key until it appears.

Note: To download information from Meridian 1 overlay applications 
can take a considerable amount of time.
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9 To capture information about additional route data blocks (RDB), enter the 
following commands in overlay 21:
> LD 21
REQ: PRT
TYPE: RDB (specify range of new RDBs you want to add to TAPI)
CUST: 0 (or customer number)
~
ACOD <cr>

10 After the information from the overlays is downloaded, on a Windows NT 
server, click Stop; on a Microsoft Windows 2000 server click Capture Text 
Stop. 

11 Close the hyperterminal application to save the information.

12 In the Symposium TAPI SP configuration application click Convert Text file 
to display the open window. (Figure 51)

Figure 51   Opening the download.txt file
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13 Select c:\m1server\download.txt. Click Open to display the Text File 
Translator Status window.(Figure 52)

Figure 52   Text File Translator Status window

14 Click Start. 

This process adds all downloaded Meridian 1 switch information to the Meridian 
TAPI Service Provider database. When the process is completed, restart FlexLM 
and ACD Proxy services and start all client and server applications. The TAPI 
server database is reread and the new TNBs are appended to the end of the 
existing database.

If all the client/server applications and ACDProxy service are stopped during the 
upgrade procedure, when you restart ACDProxy service the database becomes 
active and all new lines are visible. It is not necessary to restart the server unless 
an application was not stopped during the upgrade. 
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Adding new features or changing the TAPI environment

To add new TAPI features you must purchase a new license and perform a full 
reinstall. To add network TAPI/IVR features, you must configure these features in 
the configuration application. Refer to “Configuring the network TAPI/IVR table” 
on page 106 for information. To add Symposium Agent support refer to the 
Symposium Agent product documentation for configuration information. To add 
Symposium Web Center Portal refer to the Symposium Web Center Portal product 
documentation for configuration information.

To move from a knowledge worker environment to a call center environment you 
must purchase a new license and perform a complete reinstallation and 
configuration. For information refer to the Engineering Guidelines for Symposium 
TAPI Service Provider for Meridian 1, release 2.3.1, part number 213345-A and 
to Chapter 2, “Installation guidelines,” on page 39 and Chapter 4, “Configuration 
guidelines,” on page 87 of this document.
Network Managers Guide for Symposium TAPI Service Provider for Meridian 1, release 2.3.1



128 Chapter 5 Upgrading Symposium TAPI SP

 

213346-A



129

 

Chapter 6
Networked TAPI/IVR

When you purchase Symposium TAPI Service Provider for Meridian 1, release 
2.3.1, you choose between call center and direct connect capabilities. For each of 
these systems, you can choose an additional module that offers interactive voice 
response (IVR) and networking features. This chapter provides an overview of 
these features but does not provide installation or configuration information for 
the necessary engineering procedures. Installation and configuration must be 
carried out by qualified personnel only.

Network TAPI/IVR license file considerations

Before you can access these optional features, you must upgrade your Symposium 
TAPI license to include network TAPI and IVR capabilities. When you estimate 
the number of lines you require in your new license, include the lines used to 
monitor IVR ports in the total number of open lines required.

Each TAPI server must have a license file that includes the network TAPI/IVR 
option to receive call data for an ACD transfer or NACD overflow calls.
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Integrated IVR-CTI

The IVR and networking option available for Symposium TAPI SP enables 
integrated IVR-CTI functionality in a Meridian 1 PBX environment. The optional 
module provides an interface between the TAPI server and either the Nortel 
Networks Periphonics IVR system, or a third party IVR system.

To provide integrated IVR-CTI functionality using Symposium TAPI SP you 
require two components: the Symposium TAPI SP IVR driver that is supplied 
with the IVR and networking module, and an IVR system. This section provides a 
brief description of the Symposium TAPI SP IVR driver and the Periphonics IVR 
system. For information about integrating a third party IVR system with 
Symposium TAPI SP, refer to the Nortel Networks developer program.

Note: Nortel Networks recommends that you must not attempt to 
integrate Symposium TAPI SP with any IVR system unless you are a 
member of the Nortel Networks developer program and have expert 
knowledge of the IVR system you are installing.
213346-A



Chapter 6 Networked TAPI/IVR 131

 

IVR-CTI call flow example

This section provides a sample call flow that illustrates how caller related 
information collected by an IVR system is made available to call center agents 
through Symposium TAPI SP. Figure 53 shows the events in the sample call flow.

Figure 53   IVR-CTI call flow example

The numbers on the illustration correspond to the numbers of the following 
events:

1 A caller dials into the Meridian 1 switch over the PSTN.

2 The Meridian 1 switch queues the call to a CDN for the SCCS.

3 The SCCS opens a voice session with the IVR system.
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4 The IVR system plays a prompt for the caller, for example a request for a PIN.

5 The IVR system passes the CED to the Symposium TAPI SP IVR driver, 
where the CED and associated CLID are stored.

6 At the same time, the IVR system passes the CED to the SCCS, which assigns 
the call to a destination DN, based on skill-based routing.

7 The SCCS instructs the Meridian 1 switch to transfer the call to the 
destination DN.

8 At the same time, the SCCS passes the CLID and destination DN to 
Symposium TAPI SP, where the IVR driver searches for CED associated with 
the CLID.

9 The Meridian 1 switch transfers the call to the selected agent’s telephone set.

10 Symposium TAPI SP passes this CED to a TAPI-compliant application on the 
PC associated with the destination DN.

LAN configuration

IVR communication with Symposium TAPI SP should be on a dedicated LAN 
and not on the main C-LAN. It can share the same LAN as Meridian Link 
Services, which is installed on the SCCS. Refer to “Configuring an isolated 
C-LAN for TAPI traffic” on page 55 for further information.

IVR-CTI integration in a Meridian 1 environment

Integrated IVR-CTI functionality is possible in a Meridian 1 environment through 
the following Meridian capabilities:

• The Meridian 1 switch provides the telephony switching requirements for 
IVR activities.

• Meridian Link Services provides the call progress information that is 
necessary to track calls and gather call information.

The IVR system connects directly to the Meridian 1 switch to provide caller input 
services. The system is connected to an isolated C-LAN, which allows packet data 
transfer with Symposium TAPI SP and the SCCS.
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Symposium TAPI SP IVR driver

When you install the IVR and networking option of Symposium TAPI SP, the IVR 
driver is installed. The driver provides call data support for inbound calls 
transferred from IVR ports that are controlled by an IVR system and are 
monitored by Symposium TAPI SP. 

In a networked TAPI environment, the IVR driver also provides network call data 
support for calls overflowed from a remote Meridian 1 switch. When calls are 
overflowed, the IVR driver requests call data from the IVR driver on the remote 
TAPI server. The IVR driver uses the TCP/IP protocol to communicateswith the 
IVR system and with networked TAPI servers. 

IVR-CTI messages

IVR-CTI integration occurs through the exchange of a series of messages between 
the IVR system and the Symposium TAPI SP IVR driver. In a networked TAPI 
environment these messages are relayed by the main TAPI server to remote TAPI 
servers. The different message types are:

• A registration message is sent by the IVR system to the Symposium TAPI 
IVR driver when a call arrives on an IVR port. The registration message 
opens a connection to the IVR driver, which remains open until a 
disconnection message is sent.

• A caller data message is sent by the IVR system to the IVR driver containing 
CED received by the IVR system.

• A disconnect message is sent by the IVR system to the IVR driver when IVR 
treatment for a call is complete.

• An unsolicited status message is sent by the IVR driver to the IVR system if 
any of the ports specified in the registration message cannot be monitored. 

• A request call data message is sent by the receiving IVR driver to a remote 
IVR driver if a call is overflowed from one site to another in a networked 
TAPI environment. If this message does not include a network CLID, the 
receiving IVR driver searches for the network CLID in its IVR server 
database table in order to respond.

• A caller info data message is sent by the remote IVR driver to the receiving 
IVR driver in response to a request call data message in a networked TAPI 
environment.
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Network call data 

Nortel Networks recommends that the IVR system is centralized at the main site 
in a networked environment. To receive IVR treatment, all incoming calls are 
routed into the Meridian 1 switch at the main site. The IVR system passes the 
CLID and CED to the central Symposium TAPI SP IVR driver which stores this 
information. 

When a call is routed to a remote site, the TAPI server at that site extracts the 
HLOC from the network CLID. It checks if this HLOC is in its IVR host database 
table, and sends a request call data message over TCP/IP to the TAPI server at the 
main site. The main TAPI server then sends a caller data message to the remote 
TAPI server. All TAPI servers must be configured with the IP address and HLOC 
of the main TAPI server. These common configurations ensure that when a call 
arrives into a remote site, the remote TAPI server can match the HLOC contained 
in the network CLID with the HLOC for the main TAPI server stored in its IVR 
host database table.

There are two ways of attaching data from the IVR system to TAPI:

• If call data is associated with a network CLID, Symposium TAPI SP does not 
monitor the incoming IVR port.

• If call data is associated with a specific DN port, Symposium TAPI SP must 
monitor the incoming IVR port.

For information about configuring and maintaining the IVR host database table 
refer to “Configuring the network TAPI/IVR table” on page 106.

The Symposium TAPI SP IVR driver performs the following tasks:

• monitors IVR DNs and records associated network CLIDs 
• receives IVR registration messages which include an indication of whether 

CLID can be sent
• if the CLID cannot be sent, stores the port list as well as the source IP and port 

address of the IVR port
• receives IVR disconnect messages and removes items from the port monitor 

list associated with the source IP and port address
• receives IVR caller data from the IVR system and if the network CLID is not 

included, looks up and includes the associated network CLID
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• returns IVR caller info data messages in response to IVR request call data 
messages via TCP/IP communication

Periphonics IVR system

The Nortel Networks Periphonics IVR system is a powerful IVR system that can 
provide IVR functionality for thousands of ports, with up to 480 IVR ports 
supported in a single cabinet. The Periphonics IVR system supports the following 
IVR features:

• text to speech
• Large vocabulary speech recognition through its OSCAR speech server
• multiple speech recognition vendors, including Nuance
• self-service solutions which can include multiple layers.
• A GUI-based application builder (PeriProducer) for creating a range of basic 

to complex voice menus 

The system has two server elements: the voice processing series/information 
server (VPS/is) which provides voice services, and the integrated package for 
Meridian link (IPML) server. Both servers can co-reside on one Windows NT 
server. The IPML server can be installed only on this platform. The VPS/is server 
can also be installed on a Sun UNIX platform but it cannot then co-reside with the 
IPML server.

Overview of the VPS/is

The VPS/is is a server that integrates a variety of call processing functions with 
data communication and transaction processing. The server connects to the 
Meridian 1 switch via a TI/E1 connection to a line side T1/E1 (LST1/EI) card on 
the switch. The card provides the voice interface between the IVR system and the 
Meridian 1 switch. The LST1/EI card emulates an analog line card to the 
Meridian 1 software, and supports one T1/E1 line with 24/30 channels. You can 
configure each channel separately.
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Overview of the IPML server

The IPML server enables communication between the VPS/is server and a range 
of other interfaces including Symposium TAPI SP and the SCCS. Through the 
IPML server, the VPS/is server can perform all required telephony requests, 
responses, and events it receives from Meridian Link Services. It runs on a 
Windows NT platform only.

The IPML server provides an interface to pass caller entered data (CED), such as 
a PIN, from the VPS/is to the TAPI driver task on Symposium TAPI SP. Through 
a separate interface component the IPML server passes the CED to the SCCS.

When you install the IPML server the following configurations files are created:

cstapi.cfg
cstapils.cfg

You must customize these configuration files on the IPML server to incorporate 
specific information relating to your site. For more information refer to the 
Periphonics product documentation.

Networking call data

In the context of Microsoft TAPI, networking is defined as the ability to associate 
and deliver user data with a call. User data can be:

• an account code entered via an IVR system
• a transaction account record number
• agent-entered notes
• information relevant to an individual call

The ability to network call data facilitates the coordination of information 
available to agents when calls are transferred or conferenced locally.
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Symposium TAPI SP can consistently and reliably track call data related to calls 
that are NACD overflowed, transferred, or conferenced outside the switch to 
another Meridian 1 switch. Figure 54 shows how information is shared between 
users, TAPI servers, and Meridian 1 switches in a networked environment.

Figure 54   Networking call data

The Meridian 1 switch supports call routing between a network of Meridian 1 
switches through ISDN trunk using network automatic call distribution (NACD). 
This functionality allows Symposium TAPI Service Provider for Meridian 1 to 
track call data related to calls that overflow from one Meridian 1 switch to 
another. The call data is obtained through the network over TCP/IP. 
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Configuring networking call data capabilities

To enable networking call data capabilities the following requirements must be 
met:

1 All Meridian 1 switches must be on an ISDN trunk and configured to pass 
network CLID. In the network call trace feature on the switches, verify that 
the switches pass network CLIDs between them. For more information refer 
to the Meridian 1 switch product documentation. 

2 Verify that the NACD application (package 207) is installed on the Meridian 1 
switches by entering the following commands in overlay 22:
> LD 22
REQ PRT
TYPE PKG

3 In overlay 15, at the customer data block prompt, verify that each Meridian 1 
switch has a unique HLOC. 

4 Verify that all Symposium TAPI servers are configured for TCP/IP, by using 
the ping utility. 

5 The supplied license file for local and remote Symposium TAPI SP servers 
must include the network TAPI/IVR server option. 

6 Verify that all IVR host database tables are configured with entries for the 
HLOC, IP address, and port numbers of all participating Symposium TAPI SP 
servers. 

7 Configure the call data life span that defines the amount of time the call data 
object lasts in memory. After the call data life span elapses, call data objects 
not referenced by any call from the call data list are removed. For information 
refer to “Configuring the provider table” on page 93.

8 Configure call data size in the provider table. The valid range for call data size 
is 10 – 8192 bytes; the default value is 512 or 0x200 bytes. 

Note: Networking call data works only if the call comes from another 
ACD queue via another Meridian 1 switch. The destination of the call on 
the receiving site must be an ACD queue or CDN.
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Call data networking between IVR and Symposium TAPI SP

Call data networking between an IVR system and Symposium TAPI SP is 
possible only on IVR ports that are monitored by Symposium TAPI SP. Enable 
IVR on all IVR ports that you want to be monitored by Symposium TAPI SP in 
the configuration application. The following processes occur when call data is 
networked:

1 The IVR system registers itself with Symposium TAPI SP by connecting to a 
configured TCP port (by default 5000) and sending a registration message. 

2 When a call is placed to a line attached to the IVR system, Symposium TAPI 
SP detects the call because it is monitoring all lines on the IVR system. It 
saves the CLID for that call.

3 The IVR system plays prompts and collects data.

4 The IVR system passes the collected data to Symposium TAPI SP via TCP/IP. 

5 Symposium TAPI SP creates a call data block that contains both the call data 
and the CLID.

6 The IVR system transfers the call from its port to a destination DN on the 
switch. Typically it transfers the call to an ACD queue. In turn, the ACD 
software presents the call to a call center agent. 

7 Symposium TAPI SP informs all TAPI applications monitoring the agent’s 
telephone set of the new call. The TAPI applications retrieve the data by 
calling lineGetCallInfo. This data is commonly used for screen pop purposes.

Verifying call data networking

To verify that call data networking is operating correctly, perform the following 
tasks in the TAPI browser application:

1 Select lineInintializeEx function in the left pane of the TAPI browser 
application to display initialization information for the line. (Figure 55)
Network Managers Guide for Symposium TAPI Service Provider for Meridian 1, release 2.3.1



140 Chapter 6 Networked TAPI/IVR

 

Figure 55   TAPI browser application

2 The right hand pane displays the following information:
lineInitializeEx returned SUCCESS
num line devs = n

where n is the number of TNs successfully registered with the switch. 

3 In the left hand pane scroll OpenAllLines. Select the entry to display line 
information in the middle pane. (Figure 56)
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Figure 56   Open all lines display in the TAPI brower application

4 Use any non-monitored telephone set (TN or DN) to make a call to the IVR 
port. Follow the voice prompts set by the script to enter call data. 

At the same time, the TAPI browser displays a call appearing on one of the 
lines which is the line monitoring the current called IVR port DN.

When the call data entry is complete, the IVR system transfers the call to an 
ACD queue.

The call appears in the middle pane of the TAPI browser as “offering” to one 
of the lines in the ACD queue in which the agent is logged. 

5 Select the offering call in the middle pane . In the left pane, select the 
lineGetCallInfo function to display information for the call in the right hand 
pane. (Figure 57)
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Figure 57   Displaying call information in the TAPI browser application

The dwUserUserInfo and dwCallData fields of LINECALLINFO structure 
show the call data entered by the user.
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Call data networking between TAPI servers with NACD 
overflow

This section provides an example of how call data is communicated from a local 
Symposium TAPI SP to a remote Symposium TAPI SP. In this scenario two 
Meridian 1 switches are connected via ISDN/PRI trunks: M1-A and M1-B. An 
IVR system is attached to M1-A. Both switches use Symposium TAPI SP and the 
ACD queue to which the IVR system transfers the call is configured to 
immediately overflow to M1-B.

In this scenario the following processes occur:

1 A call arrives on a line attached to the IVR system that is monitored by the 
TAPI server. Because M1-A is part of a network of Meridian 1 switches, the 
CLID contains an identifier that uniquely identifies it as a CLID on M1-A, the 
home location code (HLOC). 

2 The IVR system plays prompts and collects data from the caller.

3 The IVR system uses TCP/IP to send CED along with information about the 
port or DN on which the data was collected to the Symposium TAPI SP for 
M1-A. 

4 The Symposium TAPI SP for Meridian 1-A updates its call data objects and 
stores them in an index-based STL data structure.

5 The IVR system transfers the call from its port to a destination DN on the 
switch. Typically, it transfers the call to an ACD queue. 

6 The call leaves M1-A and is delivered to an ACD queue on M1-B. 

7 The M1-B TAPI server receives the call. In addition to all the mandatory 
information elements, the message contains the network CLID. The M1-B 
TAPI server interprets the message as if the call originated from the remote 
Meridian 1.

8 The M1-B TAPI server extracts the HLOC from the network CLID field and 
searches its IVR host database table for the HLOC. If a match is found, it 

Note: The list of all participating TAPI service providers is read from the 
database during initialization of Symposium TAPI SP.
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sends an IVR request call data message over TCP/IP to the TAPI server for 
M1-A. 

9 The Symposium TAPI server for M1-A receives the message and, after 
searching its call data list, finds the call data for the call appearing on the 
M1-B TAPI server. M1-A TAPI server sends a caller info data message back 
to the M1-B TAPI server.

10 The M1-B TAPI server receives the caller info data message and replaces the 
CLID field with the M1-B current local call ID.

11 The M1-B TAPI server passes the data to any TAPI applications monitoring 
the agent’s telephone via a LINECALLINFO message and the subsequent 
lineGetCallInfo function call.

Verifying NACD overflow with TAPI operations

Verify that the IVR system and mlinksp.ini file are properly configured before 
starting Symposium TAPI SP. Also verify that NACD overflow time is set on the 
switch for the ACD queue on M1-A to overflow calls to an ACD queue on M1-B. 

To verify that NACD overflow is functioning correctly with Symposium TAPI SP, 
perform the following tasks in the TAPI browser application:

1 Select lineInintializeEx function in the left pane of the TAPI browser 
application to display initialization information for the line. (Figure 58)
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Figure 58   TAPI browser application

2 The right hand pane displays the following information:
lineInitializeEx returned SUCCESS
num line devs = n

where n is the number of TNs successfully registered with the switch. 

3 In the left hand pane scroll to OpenAllLines. Select the entry to display line 
information in the middle pane. (Figure 59)
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Figure 59   Open all lines display in the TAPI brower application

4 Use any non-monitored telephone set (TN or DN) to make a call to the IVR 
port. Follow the voice prompts set by the script to enter call data. 

At the same time, the TAPI browser displays a call appearing on one of the 
lines which is the line monitoring the current called IVR port DN.

When the call data entry is complete, the IVR system transfers the call to an 
ACD queue.

The NACD overflow option set on the M1-A switch causes the call to be 
overflowed to the ACD queue on the M1-B switch.

The call appears in the middle pane of the TAPI browser as “offering” to one 
of the lines in the ACD queue in which the agent is logged. 

5 Select the offering call in the middle pane and, in the left pane select the 
lineGetCallInfo function to display information for the call in the right hand 
pane. (Figure 60)
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Figure 60   Displaying call information in the TAPI browser application

The dwUserUserInfo and dwCallData fields of LINECALLINFO structure 
show the call data entered by the user.

Call data networking between TAPI service providers 
without NACD overflow

This section describes how call data is communicated from a local Symposium 
TAPI SP to a remote Symposium TAPI SP without the IVR system and NACD 
overflow switch setting. This example uses lineSetCallData to establish call data 
on an active call and then transfers or conferences to an ACD queue on the remote 
Meridian 1 switch. In this scenario two Meridian 1 switches (M1-A and M1-B) 
are connected via ISDN/PRI trunks. Both switches use Symposium TAPI Service 
Provider for Meridian 1. 
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In this scenario the following processes occur:

1 A call arrives on the ACD queue and the ACD software on M1-A presents the 
call to a call center agent. 

2 The agent selects the active call and uses lineSetCallData to set call data. 
Symposium TAPI SP informs all TAPI applications monitoring the agent’s 
telephone of the new call data available. The TAPI applications retrieve the 
data by calling lineGetCallInfo. This data is commonly used for screen pop 
purposes.

3 The Symposium TAPI SP for M1-A updates its call data objects list.

4 The agent transfers or conferences the active call to an ACD queue on the 
M1-B switch.

5 The M1-B TAPI server receives the call which, in addition to containing all 
mandatory information elements, also contains the network CLID. The M1-B 
TAPI server interprets the message as if the call originated from the remote 
Meridian 1.

6 The M1-B TAPI server extracts the HLOC from the network CLID field and 
searches its IVR host database table for the HLOC. If a match is found the 
TAPI server for M1-B sends a request call data message via TCP/IP to the 
M1-A TAPI server.

7 The TAPI server for M1-A receives the message and, after searching its call 
data list, finds the call data for the call appearing on the M1-B TAPI server. 
M1-A TAPI server sends a caller info data message back to the M1-B TAPI 
server.

8 The M1-B TAPI server receives caller info data message and replaces the 
CLID field with the M1-B current local CLID.

Verifying call data networking without NACD

To verify call data networking without NACD, perform the following tasks in the 
TAPI browser application:

1 On the Symposium TAPI server for M1-A, select OpenAllLines in the left 
hand pane.

2 On the Symposium TAPI server for M1-B, select OpenAllLines in the left 
hand pane.
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3 From another telephone set, call the DN of a monitored telephone set.

On the TAPI server for M1-A perform the following tasks in the TAPI browser 
application:

1 Select the offering call in the middle pane, and select lineAnswer in the left 
hand pane.

2 To do a blind transfer of call data select the connected line in the middle pane. 
Select lineSetupTransfer in the left hand pane.

3 Click OK. 

4 Select lineSetCallData in the left hand pane. Click OK. 

5 Select DialtoneLine in the left hand pane and click Line Dial.

6 Select IpszDestAddress. Enter a valid DN on switch B to transfer to.

7 Click OK. 

To answer an incoming call on the TAPI server for M1-B, in the TAPI browser 
application perform the following tasks:

1 Select the offering call in the middle pane and select lineAnswer in the left 
hand pane. 

2 Select lineGetCallInfo in the left hand pane to display line call information in 
the right hand pane. The dwUserUserInfo and dwCallData fields of 
LINECALLINFO structure show the call data entered by the user.

Troubleshooting IVR and networking features

This section describes some common problems encountered when configuring 
IVR and networking features for Symposium TAPI SP. When troubleshooting 
keep the logger application running. Clear the log file before you begin a 
troubleshooting session. To store important log information permanently, rename 
the overflow.log file, or save it to a different location.
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No IVR registration message on TAPI server initialization

If no IVR registration message appears in the overflow.log file capture after 
initialization of the TAPI server, perform the following tasks:

1 Use the ping utility to verify that the Symposium TAPI server and the IVR 
system are able to communicate. If there is no communication between them, 
consult your data network administrator for assistance. Otherwise, continue to 
next task.

2 Shut down Symposium TAPI SP.

3 Open the DOS Command prompt window on the TAPI server. Enter the 
following command:
netstat –a >a.txt” <Enter>

4 Open the a.txt file in Notepad or similar text editor application. 

5 If port 5000 is listed as LISTENING or ESTABLISHED it indicates that there 
is a port conflict and that the port is already in use by another application. 
Consult your data network administrator to resolve the conflict. 

6 If port 5000 is not listed, clear the overflow.log using the logger application. 
Start Symposium TAPI SP. 

7 Open the DOS Command prompt window on the TAPI server and enter the 
following command:
netstat –a >a.txt” <Enter>

8 Open the a.txt file in Notepad or similar text editor application. 

9 If port 5000 is listed as LISTENING and does not have an entry as 
ESTABLISHED, verify that the IVR system is configured for port 5000.

10 If port 5000 is listed as LISTENING and also has entry as ESTABLISHED, or 
if port 5000 is not listed as LISTENING, check the configurations for the port 
on the IVR system. Verify that the port number of the IP address for the TAPI 
server is correct.

Note: If such behaviour occurs save the overflow.log file from the logger 
application and contact Nortel Networks GNCS for assistance.
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No call data message received by TAPI server when a call is 
transferred from IVR port to ACD queue

If an improper or forced shutdown of Microsoft TAPI or Symposium TAPI SP 
occurs, it is possible that call data messages won’t be received by the TAPI server 
when a call is transferred from an IVR port to an ACD queue. To resolve the 
situation perform the following tasks:

1 Shut down Symposium TAPI SP and verify that it is shut down in the logger 
application. 

2 Stop the IVR system. 

3 Verify that the IVR system is configured to monitor each DN that is used by 
IVR ports. If any of these values require modification, reconfigure the IVR 
system.

4 Clear the overflow.log file using the logger application and start Symposium 
TAPI SP. Verify in the logger application that services have successfully 
started.

5 Start the IVR system.

6 Wait for the IVR registration message to appear in the logger window. Test 
functionality by calling IVR port DN. Follow the voice prompts to enter call 
data. 

7 When the IVR system transfers a call from the IVR port to an ACD queue, a 
call appears on an agent line logged in to that queue. Verify this procedure in 
the TAPI browser application by calling lineGetCallInfo to check call data. If 
no call data is verified, save the logs and contact Nortel Networks product 
support.

Call data appears in overflow.log file, but does not appear in 
screen pop to agent

If call data appears in the overflow.log file or in the logger application, but this 
data does not appear with a screen pop-up to an agent, perform the following 
tasks:

1 Verify that Symposium TAPI SP is monitoring all IVR ports. 
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2 Examine the IVR Caller Data message in the overflow.log file to check which 
IVR port DN is being called . Verify that this DN is included in the 
Symposium TAPI SP database for monitoring purpose. 

3 If the problem persists, save the overflow.log file and contact Nortel Networks 
GNCS.

No call data is seen when transferred or conferenced to a 
remote Meridian 1 switch

If no call data is seen when transferred or conferenced to a remote Meridian 1 
switch, perform the following tasks:

1 Verify that all Meridian 1 switches in the network are connected using ISDN/
PRI trunking.

2 Verify that all Meridian 1 switches are configured to pass network CLID. 

3 Configure the network call trace feature to verify that the Meridian 1 switches 
pass network CLIDs between them. If this is not the case, stop and consult 
switch administrator. 

4 Verify that the IVR host tables on all Symposium TAPI servers in the network 
contain the IP addresses and HLOCs of all other Symposium TAPI servers in 
the network. 
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Call data does not appear to agent when a call is transferred 
using NACD overflow

If there is call data when a call is transferred from the IVR port to an ACD queue 
on the same switch, but the call data does not appear to an agent when the call is 
transferred to a remote Meridian 1 switch using NACD overflow, it is necessary to 
verify that NACD overflow is set correctly. If NACD queues are set correctly, in 
overlay 23 the following type of information appears:

> LD 23
ACD000
MEM AVAIL: (U/P): 1941668 USED: 679771 TOT: 2621439
DISK SPACE NEEDED: 181 KBYTES
2MB BACKUP DISKETTE(S) NEEDED: 1 (PROJECTED)
ACD DNS AVAIL: 23860 USED: 140 TOT: 24000
REQ PRT
TYPE NACD
CUST 0

ACDN 7194
TABL D
ACD DN # : 7194
TABLE NAME: D
ENTRY NO TARGET ID TIMER VALUE STATUS REGISTERED
1 3258 4 ACTIVE OK

MEM AVAIL: (U/P): 1941668 USED: 679771 TOT: 2621439
DISK SPACE NEEDED: 181 KBYTES
2MB BACKUP DISKETTE(S) NEEDED: 1 (PROJECTED)
ACD DNS AVAIL: 23860 USED: 140 TOT: 24000
REQ
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Chapter 7
Compatibilities and features

This chapter provides detailed information about software compabilities with 
Symposium TAPI SP, and describes various feature interactions. 

Product compatibilities

Symposium TAPI SP is compatible with a wide range of products required for 
computer telephony integration. Before integrating the software with a product, 
check in the tables provided in this section to determine the level of compatibility.

Meridian 1 switch compatibility

Table 3 lists the Meridian 1 switches that Symposium TAPI SP supports.

Table 3   Meridian 1 switch compatibility

Symposium TAPI Service Provider

Minimum X11 software release
Release 
2.1

Release 
2.2

Release 
2.3.0

Release 
2.3.1

SCCS environment, with optional 
IVR
Release 22

Y Y Y Y

Direct connect environment, with 
optional IVR
Release 23.37

Y Y Y Y
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Telephone set compatibility

Table 4 lists the telephone sets Symposium TAPI SP supports.

Table 4   Telephone set compatibility

Symposium TAPI Service Provider

Telephone set
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

M2000 series digital telephones

M2009 Y Y Y Y

M2018 Y Y Y Y

M2317 Y Y Y Y

Meridian modular telephones (MMT)

M2006 Y Y Y Y

M2008 Y Y Y Y

M2216 Y Y Y Y

M2616 Y Y Y Y

M39xx telephones

M3901 Y Y Y Y

M3902 Y Y Y Y

M3903 Y Y Y Y

M3904 Y Y Y Y

M3905 N N Y Y

Orion telephone sets (European)

M3110 Y Y Y Y

M3310 Y Y Y Y

M3820 Y Y Y Y

Analog telephone sets

500/2500 sets Y Y Y Y

IP telephone sets

i2004 Internet telephone N N N Y

i2050 software telephone N N N Y
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Desktop PC compatibility

Table 5 lists the desktop PCs that Symposium TAPI SP supports.

Microsoft TAPI compatibility

Table 6 lists Microsoft TAPI release compatibility with Symposium TAPI SP.

Table 5   Desktop PC compatibility

Symposium TAPI Service Provider

Desktop PC
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

Windows 95 Y Y Y Y

Windows 98 Y Y Y Y

Windows NT 4.0 workstation Y Y Y Y

Windows NT 4.0 server Y Y Y Y

Windows 2000 workstation N N Y Y

Windows 2000 server N N Y Y

Windows ME Y Y Y Y

Windows XP N N N N1

1 Nortel Networks has not yet performed sanity tests on these new operating 
systems. An advisory bulletin will be issued when tests have been completed.

2 Symposium TAPI SP is not supported in a Microsoft Terminal Services 
environment, or terminal services environments from other vendors, such as 
the Citrix product.

Windows .NET N N N N1

Table 6   Microsoft TAPI compatibility

Microsoft TAPI releases Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

TAPI 2.0 Y Y Y Y

TAPI 2.1 Y Y Y Y

TAPI 3.0 N N Y Y

TAPI 3.1 N N N N1
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Windows NT service pack compatibility

Table 7 lists Windows NT service pack release compatibility with Symposium 
TAPI SP.

Microsoft Windows 2000 service pack compatibility

Table 8 lists Microsoft Windows 2000 service pack release compatibility with 
Symposium TAPI SP.

1 Nortel Networks has not yet performed sanity tests on Microsoft TAPI 3.1, which 
is provided with the new .NET operating systems. An advisory bulletin will be 
issued when tests have been completed.

Table 7   Windows NT service pack compatibility

Symposium TAPI Service Provider

Windows NT service pack
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

Service pack 3 Y Y N N

Service pack 4 Y Y N N

Service pack 5 Y Y N N

Service pack 6 Y Y N N

Service pack 6a Y Y Y Y

Table 8   Microsoft Windows 2000 service pack compatibility

Symposium TAPI Service Provider

Microsoft Windows 2000 service 
pack

Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

Service pack 1 N N Y N

Service pack 2 N N Y Y
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Interface device compatibility

Table 9 lists interface device compatibility with Symposium TAPI SP.

Nortel Networks application compatibility

Table 10 lists Nortel Networks application compatibility with Symposium TAPI 
SP.

Table 9   Interface device compatibility

Symposium TAPI Service Provider

Interface device
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

Meridian Link 5, 5C Y Y Y Y

Symposium Link 6.01 Y Y Y Y

Meridian Link Services (MLS) 4.0 N N Y Y

Meridian Link Services (MLS) 4.2 N N Y Y

Table 10   Nortel Networks application compatibility

Symposium TAPI Service Provider

Application
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

Symposium Agent 1.1 Y Y N N

Symposium Agent 2.0 Y Y N N

Symposium Agent 2.3 N N Y Y
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Third-party application compatibility

Table 11 lists third-party application compatibility with Symposium TAPI SP.

Feature support

Symposium TAPI SP supports a large number of computer telephony integration 
features and a range of administrative tools.

Basic call control 

Table 12 lists basic call control features Symposium TAPI SP supports.

Table 11   Third-party application compatibility

Symposium TAPI Service Provider

Application
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

pcAnywhere 10.5 N N N Y

Norton Antivirus N N N Y

InnoculateIT N N N Y

SAPphone R/3 2.54 N N N Y

Table 12   Basic call control

Symposium TAPI Service Provider

Feature
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

Make call Y Y Y Y

Answer Y Y Y Y

Hold Y Y Y Y

Unhold Y Y Y Y

Blind transfer Y Y Y Y

Supervised transfer Y Y Y Y

Three-party conference Y Y Y Y
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Enhanced call control 

Table 13 lists enhanced call control features Symposium TAPI SP supports.

Six-party conference Y Y Y Y

CLID Y Y Y Y

DNIS Y Y Y Y

DNIS name display N N N N

InBand ANI Y Y Y Y

Manual conference tracking 
(monitored addresses)

Y Y Y Y

Manual transfer tracking (monitored 
addresses)

Y Y Y Y

Call party name display - direct 
connect configuration only

Y Y Y Y

Multiple appearance DN1 Y Y Y Y

Generate DTMF tones N N N N

Gather DTMF tones N N N N

1 This feature has limitations. For information refer to “Multiple appearance DN 
(MADN) feature support” on page 166.

Table 13   Enhanced call control

Symposium TAPI Service Provider

Feature
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

CDN treatments (ringback, busy, 
silence, music)

Y Y Y Y

Call park (park and retrieve) N N N N

Call pickup N N N N

Night service N N N N

Table 12   Basic call control (continued)

Symposium TAPI Service Provider

Feature
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1
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ACD 

Table 14 lists ACD features Symposium TAPI SP supports.

Ring again (activate and cancel) N N N N

Swap hold Y Y Y Y

Call waiting N N N N

Call routing (redirect/blind transfer) Y Y Y Y

Table 14   ACD 

Symposium TAPI Service Provider

Feature
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

Login Y Y Y Y

Logout Y Y Y Y

Ready Y Y Y Y

Not ready Y Y Y Y

Not ready reason codes N N N N1

Walk away/return Y Y Y Y

ACD statistics Y Y Y Y

Not ready after call completed/on 
disconnect

Y Y Y Y

Emergency N N N N

Emergency reason codes N N N N1

Activity code Y Y Y Y

Night service Y Y Y Y

Call agent Y Y Y Y

Observe agent N N N N

Answer agent Y Y Y Y

Table 13   Enhanced call control (continued)

Symposium TAPI Service Provider

Feature
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1
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Lines and DNs 

Table 15 lists the line and DN capacities Symposium TAPI SP supports.

Device controls

Table 16 lists device controls Symposium TAPI SP supports.

Display agent Y Y Y Y

Supervisor key N N N NFOOT

1 The support of reason codes is a new feature available in Meridian Link 
Services 4.2. Nortel Networks will conduct sanity tests and issue an advisory 
bulletin when results are available.

Table 15   Line and DN capacities

Symposium TAPI Service Provider

Feature
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

Max DNs/Address per set 2 2 2 2

Max telephones per TAPI server 1000 1000 1200 1200

Table 16   Device controls 

Symposium TAPI Service Provider

Feature
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

Message waiting lamp activation Y Y Y Y

Make set busy — message waiting 
lamp notification

Y Y Y Y

Forward calls N N N N

Table 14   ACD  (continued)

Symposium TAPI Service Provider

Feature
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1
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Communication

Table 17 lists communication features Symposium TAPI SP supports.

Security

Table 18 lists security features Symposium TAPI SP supports.

Table 17   Communication 

Symposium TAPI Service Provider

Feature
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

IVR integration support

Call data Y Y Y Y

Network IVR Y Y Y Y

Networking support

Call data Y Y Y Y

Network CLID Y Y Y Y

Network ACD Y1

1 Networking support on release 2.1 is not compatible with later releases.

Y Y Y

ESN Y1 Y Y Y

Table 18   Security

Symposium TAPI Service Provider

Feature
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

25-pin D-type parallel port security 
device

Y Y Y Y

Keycodes Y Y Y Y

License management Y Y Y Y
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Diagnostic

Table 19 lists diagnostic features Symposium TAPI SP supports.

General administration

Table 20 lists general administrative features Symposium TAPI SP supports.

Succession CSE1000 support

Symposium TAPI Service Provider for Meridian 1, release 2.3.1, supports the 
Succession Communication Server for Enterprise 1000 (CSE1000). The IP-based 
Succession CSE1000 can be used in place of a Meridian 1 switch in your TAPI 
environment. Symposium TAPI SP delivers the same range of features and 
operates in the same manner as with a Meridian 1 installation.

Table 19   Diagnostic 

Symposium TAPI Service Provider

Feature
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

Logger application Y Y Y Y

Microsoft TAPI browser Y Y Y Y

SNMP alerts N N N N

Table 20   General administration

Symposium TAPI Service Provider

Feature
Release 
2.1

Release 
2.2

Release 
2.3

Release 
2.3.1

Dynamic database N N Y Y

Link recovery N Y Y Y

Version ID tool N N Y Y

DN/TN search N N Y Y
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Remote Office support

Symposium TAPI SP supports the Nortel Networks Remote Office 9150, release 
1.1, enabling a maximum of 32 users located in a remote office to log on to the 
TAPI server domain.

Multiple appearance DN (MADN) feature support

The MADN feature enables you to monitor calls to one DN from multiple 
telephone sets. Symposium TAPI SP supports this feature with certain limitations. 
To understand MADN operation in a Symposium TAPI environment, examine a 
scenario where you configure two lines, 4 0 0 2 and 4 0 0 3, to monitor an MADN 
of 2530. When a call is made to MADN 2530, the following process occurs on the 
telephone sets:

1 Both telephone sets show the ringing call state. 

2 If you answer the call using the 2530 address on 4 0 0 2, both telephone sets 
show the connected state but no call control is possible from the 4 0 0 3 
telephone set.

3 If 4 0 0 2 places the call on hold, either of the telephone sets can perform 
unhold.

4 The telephone set that performs unhold assumes call control.

Although the TAPI server behavior is different than usual, it provides the required 
MADN capabilities through the TAPI application. During the call, the following 
behavior occurs on the TAPI server:

1 Although both telephone sets show the ringing call state, the TAPI browser 
application shows a call offered message on line 4 0 0 2 only.

2 If you answer the call manually using the 2530 address on line 4 0 0 3, the 
TAPI browser application shows a call connected message on line 4 0 0 2 
only.

3 In this scenario, no call control is possible from the 4 0 0 2 telephone set, but 
the TAPI browser application enables you to perform call control from line 
4 0 0 2 through the TAPI application that monitors the line.

To configure MADN on Symposium TAPI SP:
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1 Assume you require the following MADN configuration:

• TN 4 0 0 2 (manager) with 2400 DN and 2530 MADN. 
• TN 4 0 0 3 (secretary) with 2300 DN and 2530 MADN. 

2 Configure TN 4 0 0 2 — for information refer to “Adding a new TN” on 
page 100. 

Symposium TAPI SP does not allow you to enter the same MADN 
information for TN 4 0 0 3 because it is already entered in the TN database for 
TN 4 0 0 2.

3 Save the information, and restart the TAPI server.

4 Run the TCMAPP application to assign lines to users.

5 Add TN 4 0 0 2 to the secretary’s user permissions to give her control of the 
manager’s MADN line, in addition to her own line on TN 4 0 0 3.
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Chapter 8
Troubleshooting

This chapter provides information on the following:

• applications you can use to troubleshoot issues with Symposium TAPI SP
• procedures for dealing with common problems

License Manager troubleshooting applications

The FlexLM License Manager contains two troubleshooting applications:

• sadbmon is a console debug monitor application that logs information when 
Symposium TAPI SP attempts to validate the features purchased by the user. 
The application is located in the tools sub-folder of the License Manager 
directory.

• a debug.log file is written by the License Manger and contains error logs plus 
status information. The file is located in the destination install folder of 
Symposium TAPI Service Provider.

Logger troubleshooting application

If a problem occurs when installing or running Symposium TAPI SP, you can run 
the logger application to create a log of activities which can help to identify the 
source of the problem. The application displays information in the logger window 
that you can save in the overflow file for review by technical personnel. 

Note: Run the logger application only if requested to do so by Nortel 
Networks GNCS.
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Before you run a troubleshooting session with the logger application, verify that 
the desired log style is selected for the feature(s) you want to troubleshoot. For 
more information refer to “Configuring the log styles table” on page 113.

Running a troubleshooting session

To run a troubleshooting session in the logger application:

1 Stop the Symposium TAPI SP application.

2 In Windows Explorer, navigate to C:\m1server\tools\logger.exe. 
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3 Start the logger application to display the logger window. (Figure 61)

Figure 61   Logger window

4 Select Options menu > Clear Overflow File. This procedure ensures that you 
save information from the current troubleshooting session only.

5 Start Symposium TAPI SP. The event and error messages that appear in the 
logger window are based on the log styles you defined for each feature in the 
host database. 
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Saving troubleshooting information

When the troubleshooting session is complete, save the information to file by 
performing one of the following procedures in the logger window:

1 Select Options menu > Append Overflow File.

2 Select File menu > Save As. Enter the desired file name and directory path. 

Controlling the size of the active log file

In a busy call center, many megabytes of information can be generated in the log 
file in less than a minute, which can affect virtual memory availability for 
Symposium TAPI SP operations. To control the size of the active log file, use the 
recycle log file option to define a maximum size in megabytes for the log file and/
or maximum time. When either of these conditions is met, the logger application 
renames the log file to the current name with a .bak extension and creates a new 
log file to continue the troubleshooting session. However, if these conditions are 
met a second time, the logger application repeats the procedure and overwrites the 
first backup file with the second backup file.

Printing the log file

You can print all the text in the log file by selecting File menu > Print, or by 
selecting the print icon located on the toolbar of the logger window. If you want to 
print only selected text in the log file, select the text you want to print and then 
select File menu > Print or select the print icon on the toolbar.

Microsoft TAPI browser application

The Microsoft TAPI browser application is provided with the Symposium TAPI 
SP software CD, or you can download it from the Microsoft Website at 
http://www.microsoft.com. To start the browser application, select Start > 
Programs > Nortel > Nortel Networks Symposium TAPI Service Provider for M1 
> TAPI browser to display the TAPI Browser window. (Figure 62)
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Figure 62   TAPI Browser window

Verifying default line properties

To verify that the default values for a line are set to monitor, owner, and 
interactive voice:
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1 Select Options menu > Default Values to display the Default Value 
Parameters window. (Figure 63)

Figure 63   Default Values Parameter window

2 In the Parameters pane, select line: dwPrivileges. Verify that MONITOR and 
OWNER are highlighted in the Bit flags pane. If monitor and owner are not 
highlighted, you can select them by holding down the control key while you 
click on both entries.

3 In the Parameters pane, select line: dwMediaMode. Verify that 
INTERACTIVE VOICE is selected in the Bit flags pane.

4 Click OK to save these default values.

5 To ensure that only active calls are monitored, in the main TAPI browser 
window, select Options menu > Auto-deallocate idle monitored calls.

6 To initialize these lines, load Symposium TAPI SP by selecting the LAp+ 
button on the tool bar.
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The middle pane lists the hexadecimal addresses where these lines are stored in 
TAPI server memory. The right-hand pane displays the number of lines that were 
initialized successfully. 

Verifying that telephone sets are configured correctly

To verify that a telephone set is configured correctly:

1 In the Symposium TAPI SP configuration application, select Meridian 1 Host 
tab > TN table button to display a list of the TNs that are configured for 
Symposium TAPI SP. Identify the telephone set associated with line 0.

2 In the TAPI browser application, click the Param check box on the toolbar. 
Click the Line+ button on the toolbar to display the lineOpen window. 
(Figure 64)

Figure 64   LineOpen window

3 Select dwDeviceID in the left-hand pane.

4 Click OK to return to main configuration window.

5 Select line 0 in the middle pane of the main TAPI browser window.

6 Perform an action with the telephone set associated with line 0. For example, 
take the receiver off hook or make a manual call to the device. 
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7 Monitor the results of these activities in the right-hand pane to verify that the 
telephone is configured correctly. 

8 For a more thorough verification, you can perform the same procedures on 
randomly selected lines.

If a success message does not appear in the right-hand pane in response to a 
specific action, start the logger application and perform the same procedures and 
save the log file for referral to technical support. For information refer to 
“Running a troubleshooting session” on page 170.

Using the TAPI browser for acceptance testing

This section describes a number of acceptance tests you can perform through the 
TAPI browser application to ensure that Symposium TAPI SP is operating 
correctly. Before you begin:

1 Start the TAPI browser application. 

2 Click the LAp+ button on the toolbar to load Symposium TAPI SP.

3 Ensure that the Parameters check box in the toolbar is deselected.

4 In the left-hand pane select OpenAllLines.

Answering an incoming call

To verify that Symposium TAPI SP answers incoming calls:

1 From another telephone set, dial the DN of a monitored telephone set.

2 Select the offering call in the middle pane. In the left-hand pane, select 
lineAnswer.

3 Click OK.

Making a blind transfer of a call

To make a blind transfer of a call:

Note: If the TAPI browser application ceases to operate for any reason, 
you must restart the server before you can restart the application.
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1 Select the connected line in the middle pane. In the left-hand pane, select 
LineBlindTransfer.

2 Click OK.

3 Select the Dialtone line in the middle pane. In the left-hand pane, select 
LineDial.

4 In the left-hand pane, select IpszDestAddress. Enter a valid DN to which to 
transfer the call.

5 Click OK.

Creating a 3-party conference call

To create a 3-party conference call:

1 Follow earlier procedures for answering an incoming call.

2 In the left-hand pane select LineSetupConference.

3 In the right-hand pane select the Dialtone line. In the left-hand pane select 
LineDial.

4 In the left-hand pane select IpszDestAddress. Enter a valid DN to which to 
conference the call.

5 In the middle pane select OnHoldPendingConference. In the left-hand pane, 
select LineAddToConference.

Calling from a digital telephone set to DN and ACD sets

To make a call on a digital telephone set for DN and ACD telephone sets:

1 In the middle pane, select a line that will make the call. In the left-hand pane, 
select lineMakeCall.

2 In the left-hand pane, select IpszDestAddress. Enter a valid DN to call.

3 Click OK.

Note: You cannot perform a blind transfer to a CDN unless you install a 
patch to Symposium TAPI SP software. For more information contact 
your Nortel Networks representative or distributor.
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Putting a call on hold and unhold

To put a call on hold and unhold:

1 In the middle pane, select a connected. In the left-hand pane, select lineHold.

2 To unhold the call, in the middle pane select the onhold call. In the left-hand 
pane, select lineUnHold.

Windows phone dialer application

Windows NT and Microsoft Windows 2000 operating systems provide a phone 
dialer application that you can use to verify that Symposium TAPI SP is operating 
correctly. To call a line monitored by Symposium TAPI SP, perform the following 
tasks:

1 Select Start > Programs > Accessories > Communications > Phone Dialer to 
start the phone dialer application.

2 Select a line number to control from the drop-down list to display the keypad.

3 Dial a known working number that can be answered. A completed call 
verifies that Symposium TAPI SP is working correctly.

Common troubleshooting issues

This section provides troubleshooting guidelines for a number of common issues. 
There are simple solutions for some issues. Other issues require that you perform 
a number of procedures in a specific order so that you can isolate the source of the 
problem.
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Symposium TAPI SP fails to initialize lines

If Symposium TAPI SP supports more than 50 lines, the lines can fail to initialize 
when you start Symposium TAPI SP. The failure occurs because the initialization 
time-out value is too low. The default and minimum value for this parameter is 32 
seconds, but you must increase the value if you are supporting more than 50 lines. 
For information on changing the initialization time-out value, refer to 
“Configuring the provider table” on page 93.

First call attempt fails

If your first attempt to make a call fails, after you install and configure the various 
hardware and software components of your TAPI environment, verify the 
following are configured correctly:

• all hardware connections
• direct connect and value added server (VAS) ID
• DCE/DTE jumper settings
• direct connect (Link 0) values
• Meridian Link (Link 1) values 
• IP address of the TAPI server 
• host database table values
• TAPI client application

Download from the Meridian 1 switch fails

After you download switch configurations from the Meridian 1 switch, if no lines 
appear in the Symposium TAPI SP database, or if you receive an error message 
indicating that the download failed, perform the following tasks:

1 Verify that the text “LD 20” appears in the download.txt file.

2 Verify that an AST value is defined for each TN. The text conversion tool 
requires an AST value to write a TN into the Symposium TAPI SP database.
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Testing connectivity

Various methods of testing the E-LAN link on the Meridian 1 switch are described 
in the Meridian 1 product documentation. Nortel Networks can request you to run 
a troubleshooting session in the logger application to log the messages that are 
exchanged during connectivity tests. 

Testing the TCP/IP connection

Use the ping command to test the TCP/IP connection from Symposium TAPI SP 
to the SCCS or to the Meridian 1 switch. To perform a ping on the connection:

1 Open a DOS window on the TAPI server.

2 Type ping [SCCS/Meridian 1 switch TCP/IP address]

3 If the ping is successful, a message is displayed saying the host was contacted.

4 If the ping is not successful, a message is displayed saying the host was not 
contacted.

5 Close the ping window by pressing Esc.

Idle message when a remote party disconnects a call

When a remote party disconnects a call, Symposium TAPI SP sends a 
disconnected call state message. To clear the call, Microsoft TAPI must also drop 
the call, by invoking the lineDrop command. This command causes Symposium 
TAPI SP to change the call state to idle. 

A call handle remains valid after a call is dropped to enable Microsoft TAPI to use 
call operations such as lineGetCallInfo to retrieve information about a call, for 
example for logging purposes. Microsoft TAPI eventually uses the linCloseCall 
command to shut down operations for the call and release the call handle. 

No telephony devices appear in TCMApp

If many TNs in a large database are removed and new ones are added, TCMApp 
adds the new lines to the end of the list of available telephony devices. If you 
cannot see any telephony devices, scroll down to find the newly added TNs.
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Connectivity problems and solutions

Table 21 provides troubleshooting solutions for a range of connectivity issues that 
you can encounter.

Table 21   Resolving connectivity issues

Problem Solution

Symposium TAPI SP does not 
load and you receive the following 
error message: Connect error, 
host %s %d 

This error message indicates that a connection cannot be made to 
Meridian Link Services on the SCCS or on the Meridian 1 switch. Use 
the ping command to check the connection, the host name, and the IP 
address of the SCCS or the Meridian 1 switch.

The connection to the Meridian 1 
switch cannot be established. The 
switch tries to connect but does 
not give a registration association 
identifier.

• On the Meridian 1 switch, use mlusr commands to check Meridian 
Link Services operation on the Meridian 1 switch. Refer to the 
Meridian 1 product documentation for information. 

• Check the Symposium TAPI SP configurations to ensure that all 
values are correct.

A client application cannot access 
Symposium TAPI SP.

• Verify that Symposium TAPI SP is registered and operational. 
• Access the Windows task manager by right-clicking the mouse on 

the Windows menu bar to verify that the TAPISRV application is 
running. 

Client applications are not 
initialized by Symposium TAPI SP.

• On the Meridian 1 switch, use mlusr commands to check Meridian 
Link Services operation on the Meridian 1 switch. Refer to the 
Meridian 1 product documentation for information. 

• Check the Symposium TAPI SP configurations to ensure that all 
values are correct.

• Access the Windows task manager by right clicking the mouse on 
the Windows menu bar to verify that the TAPISRV application is 
running. 

The switch connection drops and 
terminates calls. You receive an 
error message: Failed to allocate 
call info memory. The following 
message appears in the error log: 
Resource_limitation _rejection. 

All existing calls are aborted. While the connection is down, no new 
requests are allowed; however, Symposium TAPI SP continues to 
advertise services. The reason for this behavior is that Symposium 
TAPI SP has run out of memory and the solution is to add more 
memory to the server.
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Port conflicts

To identify whether any port conflicts exist, in a Windows NT command console, 
enter the command: netstat -a. This command generates a list containing the 
following information about ports:

• protocol — either TCP or UDP
• local address of the machine and the port that are in use 
• foreign address and port number
• state — LISTENING, ESTABLISHED, CLOSE_WAIT, or TIME_OUT 

The presence of a port 5000 on this list before you install Symposium TAPI SP 
indicates a potential conflict. 

Symposium TAPI SP stops 
responding.

• If the Meridian 1 switch fail, use Meridian 1 procedures to identify 
and correct the problem. 

• Verify that Symposium TAPI SP is registered and operational. 
• Access the Windows task manager by right-clicking the mouse on 

the Windows menu bar to verify that the TAPI SRV application is 
running. 

If Symposium TAPI SP still does not respond, shut down and restart 
your machine to close the TAPISRV application file. Uninstall and 
reinstall Symposium TAPI SP.

An incoming call over an Inbound 
ANI (IANI) trunk carrying a 10-digit 
ANI terminates at an ACD agent's 
In-Calls key. However, if the call 
appears in a TAPI-compliant 
application and the incoming caller 
hangs up (abandons the call), all 
subsequent calls to the InCalls key 
are not recognized. 

The agent must answer the next call by pressing the In-Calls key on the 
set manually.

Table 21   Resolving connectivity issues (continued)

Problem Solution
213346-A



Chapter 8 Troubleshooting 183

 

The following list is a typical example:

netstat -a
Active Connections
Proto Local Address Foreign Address State
TCP tapidmsscout:ftp 0.0.0.0:0 LISTENING
TCP tapidmsscout:70 0.0.0.0:0 LISTENING
TCP tapidmsscout:80 0.0.0.0:0 LISTENING
TCP tapidmsscout:135 0.0.0.0:0 LISTENING
TCP tapidmsscout:135 0.0.0.0:0 LISTENING
TCP tapidmsscout:407 0.0.0.0:0 LISTENING
TCP tapidmsscout:1031 0.0.0.0:0 LISTENING
TCP tapidmsscout:1035 0.0.0.0:0 LISTENING
TCP tapidmsscout:1052 0.0.0.0:0 LISTENING
TCP tapidmsscout:1691 0.0.0.0:0 LISTENING
TCP tapidmsscout:137 0.0.0.0:0 LISTENING
TCP tapidmsscout:138 0.0.0.0:0 LISTENING
TCP tapidmsscout:nbsession 0.0.0.0:0 LISTENING
TCP tapidmsscout:137 0.0.0.0:0 LISTENING
TCP tapidmsscout:138 0.0.0.0:0 LISTENING
TCP tapidmsscout:nbsession 0.0.0.0:0 LISTENING
TCP tapidmsscout:nbsession PLATFORM3:1377 ESTABLISHED
TCP tapidmsscout:nbsession BUILD:4664 ESTABLISHED
TCP tapidmsscout:1052 47.113.64.34:8888 CLOSE_WAIT
TCP tapidmsscout:1691 ntftp:ftp ESTABLISHED
TCP tapidmsscout:4029 0.0.0.0:0 LISTENING
TCP tapidmsscout:4029 ntftp:nbsession ESTABLISHED
TCP tapidmsscout:137 0.0.0.0:0 LISTENING
TCP tapidmsscout:138 0.0.0.0:0 LISTENING
TCP tapidmsscout:nbsession 0.0.0.0:0 LISTENING
TCP tapidmsscout:1029 0.0.0.0:0 LISTENING
TCP tapidmsscout:1029 localhost:1035 ESTABLISHED
TCP tapidmsscout:1030 0.0.0.0:0 LISTENING
TCP tapidmsscout:1035 localhost:1029 ESTABLISHED
UDP tapidmsscout:135 *:*
UDP tapidmsscout:407 *:*
UDP tapidmsscout:nbname *:*
UDP tapidmsscout:nbdatagram *:*
UDP tapidmsscout:nbname *:*
UDP tapidmsscout:nbdatagram *:*
UDP tapidmsscout:nbname *:*
UDP tapidmsscout:nbdatagram *:*
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Microsoft TAPI issues

 This section describes some common issues related to Microsoft TAPI.

No error recovery

If you need to restart Microsoft TAPI, for example after an application ceases to 
operate, you must shut down and restart the server. Because users can not stop the 
TAPISRV application there is no way of unloading Microsoft TAPI except by 
restarting the server.

TAPISRV unable to locate the DLL file

If you receive the error message tapisrv.exe unable to locate DLL, you 
must restart the server to enable the system to locate the DLL file.

RegisterProcessService not found

If you receive the error message RegisterProcessService not found in
kernel32.dll, you have installed a version of Windows NT 4.0 that contains an 
incorrect release of the TAPISRV application. This version of TAPISRV issues a 
call to the kernel32.dll for a RegisterProcessService, but this routine no longer 
exists in the kernel32.dll. This version of the software appears on some Microsoft 
developer CDs and the size and date of the file are:

• file size — 111,616 bytes
• date — 06/17/97 5:48pm

To resolve this problem you must either reinstall the operating system from an 
installation CD that you know to be reliable, or repair the TAPISRV application 
by upgrading from Microsoft TAPI 2.0 to a later version.

LINERR_NODRIVER error message

A LINERR_NODRIVER error message indicates that Microsoft TAPI is assigning 
the first line to a unimodem. Nortel Networks recommends that you do not install 
a modem on the TAPI server. To resolve the conflict, uninstall the modem driver 
from the server.
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LineInitializeEx reports Success when the service is stopped

When Symposium TAPI SP is stopped, Microsoft TAPI continues to load other 
TAPI providers, presenting a success report followed by the number of devices. 
However, when the Symposium TAPI SP service is stopped, the number of 
devices is reported as 0.

Meridian Link Services issues

This section contains known issues that occur when Meridian Link Services does 
not present complete information.

Meridian Link Services presents no information

Meridian Link Services presents no information on incoming calls that are not 
answered and forwarded to a CDN. However, if the call is answered manually, a 
status change message of active is presented, followed by a connected message. 

Call progress messages not delivered

If a non-AST controlled telephone is called as the consultation leg of a manually 
initiated (from the telephone and not a TAPI application) conference call, certain 
call progress messages are not delivered to the application.

For example, consider three telephones: A, B and C. Both A and B are under 
AST-control, but C is not. The agent on telephone A establishes a call to the agent 
on telephone B. Using the conference key and the key pad on A, agent A places a 
consultation call to the agent on telephone C. Because no Meridian Link Services 
messages are sent when C answers the call, Symposium TAPI SP cannot 
determine if agent C answered. In this scenario, Symposium TAPI SP registers the 
call events as follows:

• Agent A establishes a call to agent B — CallHandle1 = CONNECTED.
• Agent A places a consultation call to agent C resulting in the following:

— CallHandle1 = CONFERENCED
— CallHandle2 = DIALTONE
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— CallHandle3 = ONHOLDPENDING-CONF

• Agent C answers the consultation call and all call handles remain the same.
• Agent A completes the conference call resulting in the following:

— CallHandle1 = CONFERENCED
— CallHandle2 = CONFERENCED
— CallHandle3 = CONNECTED 

Consider a second scenario, where agent C disconnects prior to the completion of 
the conference call. Meridian Link Services does not send any message indicating 
that agent C disconnected. In this situation Symposium TAPI SP, and 
subsequently the TAPI application, lose track of the true state of the call. In such a 
scenario Symposium TAPI registers the call events as follows:

• Agent A establishes a call to agent B — CallHandle1 = CONNECTED.
• Agent A places a consultation call to agent C resulting in the following:

— CallHandle1 = CONFERENCED
— CallHandle2 = DIALTONE
— CallHandle3 = ONHOLDPENDCONF

• Agent C answers the consultation call and all call handles remain the same.
• Agent C disconnects before agent A completes the conference call and all call 

handles remain the same.

The behavior in this scenario is not typical and would not be expected by a TAPI 
application. CallHandle2 and CallHandle3 ought to change to the idle state, while 
CallHandle1 ought to change to the onhold state.

The same problem can occur with a supervised transfer, given the same three 
phones as described in the earlier scenarios. No messages are sent when agent C 
answers the consultation call, or when agent C drops a call prior to completion of 
the supervised transfer.

Note: CallHandle2 is the consultation leg of the call and CallHandle3 is 
the conference call.
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Status change messages not delivered

If a transfer consultation call is dropped after it is answered but before it is 
completed, Symposium TAPI SP does not deliver status change messages except 
in the following circumstances:

• The third party does not answer.
• The consultation call is to an AST-monitored telephone set.

If the consultation call is to an AST-monitored telephone set, the internal status is 
relayed back to the telephone set that initiated the call, enabling proper recovery.

When a three-party conference is manually created and put on hold, Meridian 
Link Services does not send a status change message to Symposium TAPI SP, 
with the result that the service provider does not know the call is on hold.

Dropping the original call during consultation transfer

If the original call is dropped while the consultation call is ringing, Symposium 
TAPI SP fails.

Transferring number not displayed

When transferring a call, Meridian Link Services supplies only the DN of the 
party performing the transfer if the destination party DN is AST-controlled. 

Blind transfer fails

It is not possible to perform a blind transfer to a CDN unless you install a patch for 
Symposium TAPI SP. For information refer to Nortel Networks GNCS.

Caller ID not reported

Meridian Link Services does not transfer the CLID to the called party in a 
conference call if the receiving DN is not AST-controlled. The CLID of the party 
initiating the conference displays as unknown. 
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Call status messages sent by Meridian Link Services

Meridian Link Services still sends call status messages, even if you select 
outbound call processing only in the configuration application. It is normal 
practice to select inbound call processing as well.

Called number not displayed when routed to a CDN

Meridian Link Services presents the calling number, but not the called number, 
when the incoming call is transferred or forwarded to a CDN. For example, 2495 
calls 2491, 2491 forwards the call to a CDN (2121). The route request message 
shows the calling number (2495) but not the called number (2491).

Call parking not supported

Meridian Link Services does not support call parking. There are no park or unpark 
status change messages. When a call park is performed manually at the telephone 
set, the call is reported as on hold and does not go off hold. If the call is not picked 
up, a new call is presented in addition to the onhold call, with the same CLID as 
the CLID of the held call.

Enhanced ISDN progress messages for outbound calls

Meridian Link Services provides additional information on the progress of 
networked calls for outbound calls provided by the Meridian 1 switch over ISDN. 
The Meridian Link protocol, minimum release 5, supports all of the following 
ISDN-related, information element (IE) messaging: 

• 1 — unallocated (unassigned) number 
• 3 — no route to destination
• 17 — user busy 
• 18 — no user responding
• 22 — number changed 
• 27 — destination out of order
• 28 — invalid number format (address incomplete) 
• 34 — no circuit/channel available
• 38 — network out of order 
• 41 — temporary failure
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• 42 — switch equipment congestion 
• 127 — interworking, unspecified with inband information available

Predictive dialer and outbound dialing applications can process more calls in less 
time by interpreting the called party status. Invalid numbers can be compiled and 
manually updated by agents to increase the accuracy of the customer database.
Network Managers Guide for Symposium TAPI Service Provider for Meridian 1, release 2.3.1



190 Chapter 8 Troubleshooting

 

213346-A



191

 

Glossary of acronyms

A
ACD

automatic call distribution   

ANI 
automatic number identification 

AST
associated set

B
BDC

backup domain controller

C
CDN

control destination number

CED 
caller entered data   

C-LAN 
customer LAN   

CLID
calling line identification

CPU 
central processing unit   

CSE1000
Communication Server for Enterprise 1000

CTI 
computer telephony integration 

D
DN 

directory number   

DNIS 
dialed number identification service 

DNS
domain name service

E
E-LAN 

embedded LAN   

ESN 
electronic switched network   

G
GB 

gigabyte   

GUI 
graphical user interface   

H
HDX 

Host Data Exchange   

HLOC 
Home Location Code    
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I
IP 

Internet Protocol   

IPML
integrated package for Meridian Link

ISDN 
integrated services digital network

IVR
interactive voice response

L
LAN 

local area network   

LOC 
Location code    

LST1/EI card
line side T1/E1 card

M
MADN

multiple appearance directory number

MAT 
Meridian Administration Terminal   

MB 
megabyte  

MCN
multiple call no ring

MCR
multiple call ring

MSB 
make set busy   

N
NACD

network automatic call distribution

NMS 
Network Management System   

NRD 
not ready 

NSBR 
network skill based routing

O
OTM 

Optivity Telephony Manager   

P
PBX 

private branch exchange   

PDC
Primary Domain Controller

PEP
product enhancement package

PIN
personal identification number

PSTN 
public servic telephone network   

PVI
platform vendor independent

R
RAM 

random access memory   

RAN
recorded announcement
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RAS
remote access services

RDB
route data block

RPC
remote procedure call

RSP
remote service provider

S
SAM database

security account management database

SBR 
skill based routing   

SCCS
Symposium Call Center Server

SECC
Symposium Express Call Center

Symposium TAPI SP
Symposium TAPI Service Provider

T
TAPI

telephony application programming 
interface

TAPISRV
Microsoft TAPI server

TCP/IP 
Transport Control Protocol/Internet Protocol   

TN 
terminal number   

TNB
terminal number block

V
VLAN 

virtual LAN  

VPS/is
voice processing server/information server

W
WAN 

wide area network  
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A
ACD

features supported with releases of Symposium 
TAPI SP 162

overview 31
proxy service overview 31

active desktop domain management 65
additional database

configuration 116
administrative features suported by releases of 

Symposium TAPI SP 165
agent walkaway

logger application display 32
assigning lines to clients

Microsoft Windows 2000 server 84
Windows NT 4.0 server 79

auto link recovery
Meridian 1 switch 34
overview 34
Symposium TAPI SP 34

automatic call distribution. See ACD

B
backup domain controller. See BDC
BDC

overview 64

C
call center environment

C-LAN 26
dynamic database updating 87
E-LAN 26
feature interactions 35
illustration 26
installation 53
installing Symposium TAPI SP 56
isolated C-LAN 55
LAN requirements 53
Meridian Link Services 25
overview 25

SCCS LAN connectivity 26
skill-based routing 25
Symposium Express Call Center (SECC) 26

call control
basic features supported 30
basic features supported with releases of 

Symposium TAPI SP 160
enhanced features supported 31
enhanced features supported with releases of 

Symposium TAPI SP 161
call data 153

associated with a network CLID 134
associated with a specific DN port 134
configuring life span in the provider table 94
configuring size in the provider table 94
disabling copy to consultative calls in the 

provider table 94
NACD overflow 38
network CLID 138
network TAPI 38
networked 134
networking between IVR and Symposium TAPI 

SP 139
networking between TAPI servers with NACD 

overflow 143
networking configuration 138
networking verification 139
not presented in screen pop 151
not seen in consultatitive call 152
supported by IVR driver 133
tracking NACD overflow 137
verifying without NACD 148

CDN
adding to Symposium TAPI SP database 105
configuring in Symposium TAPI SP 

database 104
deleting from Symposium TAPI SP 

database 106
downloading from Meridian 1 switch 89
modifying in Symposium TAPI SP 

database 105
CDN table

adding a new CDN 105
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configuration 104
deleting a CDN 106
modifying a CDN 105

C-LAN
call center environment 26
data traffic 43
isolated, configuration 55
isolating TAPI traffic 55
isolation 43
SCCS 26

CLID
monitoring 134

client user logon issues 76
communication features supported by releases of 

Symposium TAPI SP 164
configuration

adding a telephony administrator on Microsoft 
Windows 2000 server 84

additional database 116
after a software upgrade 120
assigning lines to clients on Microsoft Windows 

2000 server 84
automatic 29
configuring database tables 92
converting the text file from Meridian 1 switch 

download 89
defining a routing table 44
domains on a Windows 2000 server 72
downloading Meridian 1 switch information 88
E-LAN 43
enabling telephony services on Microsoft 

Windows 2000 server 81
FlexLM License Manager 60
increasing the number of clients 123
isolated C-LAN 55
manual 30
Meridian 1 Host table 95
Microsoft TAPI 77
Microsoft TAPI on Microsoft Windows 2000 

server 80
Microsoft TAPI on Windows NT 4.0 server 78
network TAPI/IVR table 106
provider table 93

recovering database information after a software 
upgrade 121

retaining line associations after a software 
upgrade 121

TAPI clients 86
trunk table 97
verifying a software upgrade 121
Windows NT server as a PDC 71
Windows NT server as a standalone server in a 

domain 69
configuration application

CDN table 104
configuring database tables 92
configuring the provider table 93
converting the text file from Meridian 1 switch 

download 89
log styles table 113
Meridian 1 Host table 95
network TAPI/IVR table 106
overview 34
TN table 100
treatments table configuration 98
trunk table configuration 97

customer LAN. See C-LAN

D
debug.log

overview 35
desktop PC compatibility with Symposium TAPI 

SP releases 157
devices controls supported by releases of 

Symposium TAPI SP 163
diagnostic features supported by releases of 

Symposium TAPI SP 165
direct connect environment

ACD 25
dynamic database updating 87
feature interactions 36
illustration 27
installation 47
knowledge worker environment 27
overview 27
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DN
adding to Symposium TAPI SP database 103
configuration 100
deleting from Symposium TAPI SP 

database 104
IVR monitoring 134
modifying in Symposium TAPI SP 

database 103
number supported with releases of Symposium 

TAPI SP 163
domains

active desktop 65
backup domain controller (BDC) 64
client user logon issues 76
common causes of RPC failure 75
configuring a Windows NT server as a PDC 71
configuring a Windows NT server as a 

standalone server 69
configuring on a Microsoft Windows 2000 

server 72
domain controllers 64
master security database 64
member 64
Microsoft trust relationships 

recommendations 66
modem-based applications issues 77
non-standard multidomain configuration 68
overview 64
primary domain controller 64
remote access services (RAS) issues 76
remote procedure call 75
reverse RPCs 75
RPC behavious in a typical TAPI call 75
SAM database maximum size 65
SAM database overview 64
standalone server 64
standard multidomain configuration 67
Symposium TAPI SP considerations 66
validating RPC configuration 76
Windows 2000 server 65

downloading control directory number (CDN) 
blocks 89

downloading route data blocks 89

downloading terminal number blocks 88
dynamic database

call center environment 87
direct connect environment 87
overview 34

E
E-LAN

assigning an IP address 44
call center environment 26
configuration 43
isolation 43
SCCS 26
telephony traffic 43

embedded LAN. See E-LAN
enabling telephony services

Microsoft Windows 2000 server 81
Windows NT 4.0 server 79

F
feature interactions

call center environment 35
direct connect 36
general 36
knowledge worker environment 36
SCCS 35

FlexLM License Manager
configuration 60
overview 30
troubleshooting overview 35
upgrading 121

I
increasing the number of clients 123
installation

call center environment 53
direct connect 47
full reinstall of Symposium TAPI SP 118
knowledge worker environment 47
PEP on a Microsoft Windows 2000 server 118
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PEP on a Windows NT 4.0 server 118
SCCS prerequisites 54
security device 42
Symposium TAPI SP 48
Symposium TAPI SP in a Call Center 

environment 56
uninstalling an earlier release from a Microsoft 

Windows 2000 server 119
uninstalling from a Windows NT 4.0 server 119
verifying PEP installed successfully 118

interactive voice response. See IVR
interface device compatibility with releases of 

Symposium TAPI SP 159
IP address

activating 45
Meridian 1 switch 44
recovery 46
validation 45

IVR
adding a remote IVR host address to Symposium 

TAPI SP database 108
adding IP address to Symposium TAPI SP 

database 108
adding Meridian 1 switch HLOC to Symposium 

TAPI SP database 108
call data networking and Symposium TAPI 

SP 139
call data not presented in screen pop 151
call flow example 131
caller data message 133
caller info data message 133
CTI integration with Meridian 1 switch 132
deleting a remote IVR host address to 

Symposium TAPI SP database 110
disconnect message 133
driver for Symposium TAPI SP 133
driver support for network call data 133
intergration CTI capabilities with Symposium 

TAPI SP 130
IPML 130
IPML overview 136
IVR port address in Symposium TAPI SP 

database 108

IVR-CTI messages 133
LAN configuration 132
license file considerations 129
modifying a remote IVR host address in 

Symposium TAPI SP database 109
monitor DNs 134
monitor network CLIDs 134
network call data 134
networked call data between TAPI servers 143
no registration message on TAPI server 

initialization 150
overview 28, 33
Periphonics IVR system 130
Periphonics system overview 135
port list 134
port monitor list 134
registration message 133
request call data message 133
troubleshooting 149
troubleshooting call data not presented with 

NACD overflow 153
troubleshooting call data not seen in consultative 

call 152
troubleshooting call data transferred from IVR 

port to ACD queue 151
unsolicited status message 133
verifiying call data networking 139
verifying call data networking iwthout 

NACD 148
VPS/is 130
VPS/is overview 135

K
knowledge worker environment

ACD 25
direct connect 27
feature interactions 36
illustration 27
installation 47
overview 27
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L
LAN

call center environment 26
call center environment requirements 53
configuration 43
IVR configuration 132
SCCS connectivity 26
SCCS requirements 53

license file
configuration 60
management overview 30
maximum number of DNs supported 30
network TAPI/IVR considerations 129
upgrading 121

line associations
retaining after a software upgrade 121

link loss detection 97
log style

configuration 113
provider table 94
treatments table 98

log styles table
adding a log style 114
configuration 113
default log styles 113
deleting a log style 115
editing a log style 115

logger application
adding a log style 114
agent walkaway feature 32
configuring log styles 113
default log styles 113
deleting a log style 115
editing a log style 115
overview 34

M
MADN feature support for Symposium TAPI 

SP 166
management applications

configuration application overview 34

license file troubleshooting overview 35
logger application overview 34
TAPI browser application overview 35

Meridian 1 Host table
CDN table 104
configuration 95
customer number 96
host address 96
host name 96
host port 96
machine name 96
Meridian 1 release 96
Meridian Link release 96
monitor all DNs/no DNs 97
phantom DN 96
polling interval 97
registration password 96
services 97
TN table 100
treatments table 98
trunk table 97

Meridian 1 switch
activating an IP address 45
assigning an IP address 44
auto link recovery 34
defining a routing table 44
downloading switch information to TAPI 

server 88
IP address recovery 46
ISDN trunks to other switches for NACD 137
IVR-CTI integration capabilities 132
optional applications 42
required applications 41
Symposium TAPI SP release compatibility 155
TAPI-enabling 41
validating an IP address 45

Meridian Link Services
overview 29

Microsoft TAPI
assigning lines to clients on Microsoft Windows 

2000 server 84
assigning lines to clients on Windows NT 4.0 

server 79
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client domain 63
client machine 63
client machine domain 63
client user 63
client user issues 76
compatibility with Symposium TAPI SP 157
configuration 77
configuring TAPI clients 86
enabling telephony services on Microsoft 

Windows 2000 server 81
enabling telephony services on Windows NT 4.0 

server 79
modem-based applications issues 77
overview 29
remote access services (RAS) issues 76
remote service provider 63
server machine 63
server machine domain 63
server service 63
server user 63
server user domain 63
TAPISRV application 29
terminology 63
trust relationships recommendations 66
Windows NT 4.0 server configuration 78

Microsoft Windows 2000
service pack compatibility with releases of 

Symposium TAPI SP 158
Microsoft Windows 2000 server

adding a telephony administrator 84
assigning lines to clients 84
configuring Microsoft TAPI 80
enabling telephony services 81
installing a PEP 118
Microsoft TAPI configuration 80
RPCs 75
uninstalling an earlier release 119

Microsoft Windows remote service provider 29

N
NACD

ISDN trunking between Meridian 1 
switches 137

Meridian 1 switch application 138
network TAPI overview 37
overflow and call data 38
overflow of call data between networked TAPI 

servers 143
overflow verification 144
verifying call data networking without 

NACD 148
network TAPI

call data and NACD overflow 38
call data networking requirements 38
call data overview 37
overview 37

network TAPI/IVR table
adding Meridian 1 switch HLOC 108
configuration 106
deleting a remote host address 110
IP address of IVR server 108
IVR port address 108
modifying a remote host address 109
remote host address 108

Nortel Networks application compatibility with 
releases of Symposium TAPI SP 159

not presented with NACD overflow 153

O
outbound dialing applications

overview 33

P
PDC

configuring a Windows NT server 71
master security database for domain 64
overview 64
SAM database maximum size 65

PEP
installation 117
installing on a Microsoft Windows 2000 

server 118
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installing on a Windows NT 4.0 server 118
verifying installation 118

Periphonics IVR overview 135
platform vendor independent (PVI) 23
predictive dialing applications

overview 33
primary domain controller. See PDC
product enhancement package. See PEP
provider table

application name 94
call data life span 94
call data size 94
command timeout value 94
configuration 93
disable copy of call data to consultative call 94
initialization timeout value 94
log style 94
shutdown timeout value 94

R
Remote Office support for Symposium TAPI 

SP 166
remote procedure call. See RPC
routing table

configuration 44
RPC

common causes of failure 75
in a typical TAPI call 75
Microsoft Windows 2000 server 75
reverse 75
trust relationships overview 75
validating configuration 76

S
SADDBMON

overview 35
SAM database

maximum size 65
SCCS

C-LAN 26

E-LAN 26
feature interactions 35
illustration 26
Meridian Link Services 25
skill-based routing 25
TAPI-enabling 54

security
features suported by releases of Symposium 

TAPI SP 164
overview 33

security account management database. See SAM 
database

security device
installation 42

Succession CSE1000 support for Symposium TAPI 
SP 165

Symposium TAPI SP 71
ACD features supported 162
adding new features 127
administrative features supported 165
auto link recovery 34
basic call contol features supported 160
call data networking and IVR 139
changing the TAPI environment 127
communication features supported 164
compatibility with Microsoft TAPI 157
compatibility with Microsoft Windows 2000 

service packs 158
compatibility with Windows NT 4.0 service 

packs 158
configuration application overview 34
configuring a Windows NT server as a 

standalone server in a domain 69
configuring domains on a Microsoft Windows 

2000 server 72
desktop PC compatibility 157
device controls supported 163
diagnostic features supported 165
domain considerations 66
dynamic database overview 34
enhanced call control features supported 161
increasing the number of clients 123
installation 48
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installation in a call center environment 56
installation in a SCCS environment 56
integrated IVR capabilities 130
Interface device compatibility 159
isolated C-LAN configuration 55
IVR driver 133
IVR-CTI call flow example 131
IVR-CTI messages 133
logger application overview 34
Meridian 1 switch release compatibility 155
Microsoft TAPI configuration 77
non-standard multidomain configuration 68
Nortel Networks application compatibility 159
number of DNs supported 163
number of lines supported 163
recovering information after a software 

upgrade 121
security features supported 164
standard multidomain configuration 67
support for MADN feature 166
support for Remote Office 166
support for Succession CSE1000 165
telephone set compatibility 156
third-party application compatibility 160
upgrading 117
upgrading features 123

T
TAPI browser application

overview 35
TAPI client

configuration 86
PCs supported 23

TAPI server
backup domain controller (BDC) 64
domain member 64
domain stanadalone server 64
domains 64
downloading Meridian 1 switch information 88
installing the security device 42
primary domain controller 64
upgrading Symposium TAPI SP 117

TAPIAdmin 78
TAPIClient 78
TAPISRV. See TAPI browser application
target audience 24
TCMApp 78
TCMSetup 78
telephone set

overview of control features 32
Symposium TAPI SP release compatibility 156

third-party application compatibility with releases 
of Symposium TAPI SP 160

TN
adding to Symposium TAPI SP database 100
configuration 100
deleting from Symposium TAPI SP 

database 102
modifying in Symposium TAPI SP 

database 101
TN table

adding a DN 103
adding a new TN 100
configuration 100
deleting a DN 104
deleting a TN 102
modifying a DN 103
modifying a TN 101

treatments table
adding a new treatment 99
configuration 98
deleting a treatment 99
log style 98
route number 98
treatment name 98
treatment type 99

trunk monitoring
overview 33

trunk table
adding a range of route numbers 98
adding a route number record 97
configuration 97
deleting a route number record 98
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deleting all route numbers 98
trust relationships

common causes of RPC failure 75
remote procedure call 75
reverse RPCs 75
RPC behaviour in a typical TAPI call 75
validating RPC configuration 76

U
upgrading

adding new features 127
changing the TAPI environment 127
product enhancement package 117
Symposium TAPI SP 117

W
Windows NT 4.0 server

assigning lines to clients 79
enabling telephony services 79
intalling a PEP 118
Microsoft TAPI configuration 78
service pack compatibility with releases of 

Symposium TAPI SP 158
uninstalling an earlier release 119
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